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First Things First 
What is CD? 
CD stands for Compact Disc, which is a general term for all formats of CD media. CD formats available 
on the market now include Audio CD, CD-ROM, CD-ROM XA, Photo CD, Video CD and others. 

Among this variety of CD formats, the most familiar one is perhaps Audio CD, which is a standard CD 
format used for storing audio sound tracks, for example, music and songs. Due to the immense success 
of Audio CD, today the use of this media has been expanded into storing data, for the purpose of data 
archival and distribution. 

Compared to traditional data storage alternatives such as floppy disk and tape, CD is best for the storage 
of large amounts of data. CDs can store any form or combination of computer files, audio data, photo 
image files, software applications and video data. The benefits of using CD include durability, 
convenience, and cost effectiveness.  

A Brief Overview of CD-R Technology 
In 1989, Taiyo Yuden Company of Japan developed an organic dye-based CD medium that was coated 
with a thin layer of gold. This new medium not only provided the same physical characteristics and 
capacity as silver pressed CDs, but also had better reflective properties than commercially replicated 
CDs. Two types of devices that are able to write information to a CD Recordable (CD-R) disc are (1) 
Compact Disc Recorder (CD-Recorder) and  (2) Compact Disc ReWritable Recorder (CD-RW 
Recorder). A CD-RW Recorder can write to a CD-R disc as well as a CD ReWritable Recordable (CD-
RW) disc. The invention of CD-R and CD-RW technology brings many benefits:  

1. You are able to make your own CD-ROM discs on a desktop PC at a low cost. 

2. You are able to select a suitable CD format to record your information.  

3. You can now avoid expensive mastering costs associated with commercial 
mastering & replication facilities.  

Since a typical CD-R medium has a life span of 70 - 100 years, it is ideal for durable data archival. This is 
a remarkable enhancement over magnetic media, which has a much shorter life span. CD-R technology 
is a breakthrough that will usher in the next revolution in data storage technologies as the need for large 
capacity forever increases in this age of information explosion. 

A Quick Look at CD Recorders 
The first manufacturers of CD Recorders were Yamaha and Sony. The first generation CD Recorders 
produced were single speed (150 Kbps) drives, also called 1X drives. Since then, a number of CD 
Recorders from various manufacturers have become available on the market. The speed of the later 
generation of recorders has improved to 2X, double speed (300 Kbps), 4X, quad speed (600 Kbps), 8X 
(1200 Kbps), and 12X (1800 Kbps). With the rapid progress of CD recording technology, the recording 
speed of CD Recorders is expected to increase to 52X in the near future. 

CD Recorders can be either external or internal devices. An external drive can be situated separate from a 
PC body, while an internal drive must be installed within the PC. Operationally, compared to floppy or 
hard disk drives that you are familiar with, one of the characteristics of CD Recorders is that during a 
write operation they require a steady flow of data. All CD Recorders have a buffer memory called cache. 
During a write operation to the disc, the cache contains a certain amount of data to be written to the 
disc. During the entire write operation, the cache should never be depleted. There must be a steady 
stream of data that is neither too fast nor too slow, constantly flowing from the PC (RAM or hard disk) 
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into the recorder’s buffer cache. Driving this steady data stream may require a powerful PC and its 
dedicated resources. 

CD Recorders have either IDE, SCSI or USB interfaces. For SCSI CD-Recorders, you need to connect 
it with a SCSI cable to the PC with a SCSI controller installed. Current CD-Recorders were designed for 
CD recording and can be used as a CD-ROM drive. 

About CD-Recordable & CD-ReWritable Recordable Technology 
A CD-ReWritable (CD-RW) Recorder is a CD-Recorder with the additional capability of being able to 
write CD-ReWritable (CD-RW) recordable discs. It is both a CD-Recorder and CD-ReWritable 
Recorder. It can be used to write to a CD-Recordable (CD-R) disc as well as CD-ReWritable (CD-RW) 
Recordable disc. 

As previously stated, if your CD Recorder is a CD-RW Recorder you have the option of using the two 
different types of CD-Recordable discs. 

Both CD-Recordable (CD-R) disc and CD-ReWritable Recordable (CD-RW) disc have there own 
unique benefits as shown:  

C D  R E C O R D A B L E  ( C D - R )  D I S C  

� Excellent for long-term archived data storage.  

� Low inexpensive cost per CD-Recordable (CD-R) disc.  

� CD-Recordable (CD-R) disc can be read by any CD-ROM drive. 

� CD-Recordable (CD-R) Audio (Music) CD’s can be played in any CD Player! 
C D  R E - W R I T A B L E  ( C D - R W )  R E C O R D A B L E  D I S C  

� Excellent for short-term data storage (i.e. data file back-ups). 

� Cost effective daily data backup alternative. 

� CD ReWritable (CD-RW) Recordable discs may be erased and re-used up to 1000 times!  

� Allows you to test your CD-RW Recorder as well as allowing you to practice making CD’s 
without wasting or ruining CD-Recordable media.  

Note: 

0 If you want to read back a written CD-RW disc using a CD-Recorder or CD-ROM drive, the 
CD-Recorder or CD-ROM drive must be either ReWritable playback or Multi-Read 
compliant. 

About CD Standards (ISO 9660)    
ISO 9660 is an internationally accepted logical level standard that defines the format of files and 
directories on a CD-ROM. The ISO 9660 standard allows different computers with different operating 
systems to access the same data format. CD-ROMs current success is due to not only the media’s own 
distinct advantages but also to the universal acceptance and interoperability of the media, accomplished 
through standards like ISO 9660. 
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ISO 9660 File System 
All computer platforms address the data on the compact disc as a file system. The file system was 
designed to be common to UNIX, VAX/VMS, MS-DOS and Mac, and their various derivatives. ISO 
9660 is meant to be compatible with various operating systems.  

Such compatibility is accomplished by using the common capabilities of all target systems. 
Consequently, ISO 9660 has several restrictions, including the following: 

• No directory tree of more than eight (8) levels in depth 
• No long filenames: a filename including its extension must be less than 30 characters. 

However, for use in MS-DOS, it is much more restricted: up to 8 characters for the file name, 
and 3 characters for the extension 

• No extensions in directory names 
• Uppercase characters only 
• Some special characters, such as % or @, are not allowed. 

NTI CD-Maker will help you create an ISO 9660 image file before you formally send data for recording 
to your CD Recorder. This is convenient and helps eliminate run-time recording errors. 

Joliet and Romeo File Systems 
There are a few restrictions in ISO9660 such as character set limitations, file name length limitations and 
directory tree depth limitations. These restrictions may prevent some users from copying their data onto 
a CD-ROM that can be read by different computer platforms. Therefore, several operating system 
vendors have extended the ISO9660 file system in several ways. 
Joliet 
The Joliet file system was proposed and implemented by Microsoft. Joliet is based on the ISO9660 
(1988) standard.  

If a CD is created using the Joliet file system, it may only be read back under Windows 95 / Windows 
NT 4.0 or later, and may not be read back on other platforms. Under the Joliet file system, the number 
of characters allowed in long file name is up to 64 and the allowed number in a long directory is up to 
64 characters. However, the total number of characters for a file name plus its full path cannot exceed 
120. 

Romeo  
Romeo is defined as Windows 95 long file names only, up to 128 characters. NTI CD-Maker, Version 
of 3.0 and above, supports the Romeo file system. 

Universal Disk Format (UDF) 
Universal Disk Format is a file system for optical media developed by the Optical Storage Technology 
Association (OSTA). It was designed for read-write interoperability between all the major operating 
systems as well as compatibility between rewritable and write-once media. UDF supports file names up 
to 255 characters long. 
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About NTI CD-Maker 
NTI CD-Maker is a CD mastering software. Using CD-Maker and a supported CD/DVD recorder, 
you can produce Compact Discs in various formats, including CD-ROM, CD-ROM XA, DVD-ROM, 
Audio CD, Video CD, Mixed Mode and CD Extra. 

The familiar Windows interface makes CD-ROM publishing as easy as dragging and dropping files or 
pointing and clicking a mouse. Simply drag and drop files from your source hard disk or other media to 
your CD layout image and in minutes you will have mastered your own CD. 

CD-Maker’s intuitive user interface allows you to instantly navigate your way around your computer to 
locate files easily. Locate files using the Windows's find utility easily from the toolbar. Our all-new user 
interface has never been easier. All operations are accomplished in very simple steps. Each step is clearly 
identified by CD-Maker. 

Recording most CD types is a simple two-step process. Step one, layout the target disc using tools like 
Explorer and Find directly from the CD-Maker window. Step two writes the CD. Creating your own 
CDs has never been easier or faster Using CD-Maker and now you can create your own personalized 
jewel case covers and CD labels with NTI's new JewelCase Maker program. 

NTI CD-Maker Gold offers the following advantages, making it the best and easiest solution for 
making your own CDs. 

• Takes advantage of 32-bit power of Windows and supports long file names. 
• Copy supports most major CD formats, including: CD-ROM, CD-ROM XA, DVD-ROM, 

Audio CD, Video CD, Mixed Mode and CD Extra. 
• Premasters Data CD (CD-ROM, CD-ROM XA, DVD-ROM), Audio CD, Video CD, 

Mixed-Mode CD and CD Extra formats. 
• FileCD for convenient drag-and-drop packet-writing to DVD-RW/+RW or CD-RW media. 
• Makes Audio CD from WAV, WMA or MP3 files. 
• Online database access to identify Audio CDs and tracks. 
• VCD/SVCD Menuing. 
• MPEG-1 encoding converts avi files to MPEG-1 format for Video CD mastering. 
• Drag & Drop files to create disc images. 
• Adjustable software settings make CD recording a smooth and reliable operation. 
• Read track will backup a track from a disc in the CD-Recorder to a hard disk. 
• Compile Audio CD sounds from various source CDs to a CD-R disc with a minimum hard 

disk space requirement 
• Multi-session support. 
• Session Explorer and File Compare Utility  
• Track-At-Once, Disc-At-Once and Session-At-Once recording. 
• User selectable inter-track gap. 
• NTI Plug-In support to enhance the power of your CD-Maker software. 



I N T R O D U C T I O N  

Introduction     7 

In addition to the above, NTI CD-Maker Platinum offers the following features: 
• Records Audio CD’s on the fly directly from line-in and microphone, ideal for live sound 

recording such as Karaoke. 
• Premasters MP3, WMA, Super VCD and Custom CD. 
• MPEG-2 encoding converts avi files to MPEG-2 format for SuperVideo CD mastering. 
• VCD/SVCD Slide Show with and without background audio. 
• MP3 encoding converts CD tracks, WMA and WAV files to MP3 format. 
• WMA encoding converts CD tracks, WAV and MP3 files to WMA format. 
• New and improved JewelCase Maker utility to design your own CD labels and jewel-case 

inserts. 
• Wave Editor with Trim, Normalize, Fade, Echo, Filter and Amplify functions. 
• Create a MP3 CD from any supported audio track. 
• Create a WMA CD from any supported audio track. 

Supported CD Format Types 
Using CD-Maker, you can create many types of CD/DVD discs: CD-ROM, DVD-ROM, Audio CD, 
Video CD, Super VCD, Mixed-Mode CD and CD Extra. 
A CD-ROM disc contains data only. For example, when you back up all the data files from your hard 
disk to CD, the disc that will be created is a CD-ROM disc. 
An Audio CD disc contains only digital audio information. The sources of digital audio are Audio CD 
(music or songs) on a disc in a CD-ROM drive, music (WAV, WMA or MP3) files on your hard disk or 
live Audio input from a microphone connected to your PC's sound card. 
A Video CD disc may include video clips, converted from MPEG-1 files. Video clips must conform to 
the MPEG for Video CD 2.0 specification. 
A Super Video CD disc may include video clips, converted from MPEG-2 files. Video clips must 
conform to the MPEG-2 (ISO 13818-1, 1994) specification. 
A Mixed Mode disc contains both data and digital audio. Data is recorded on the first track, while 
audio is on tracks 2 to 99 of the same disc. 
CD Extra, also known as CD Plus or Enhanced CD, includes two sessions with the first session 
containing up to 98 audio tracks and the second session containing a data track written in the CD-ROM 
XA format. 

CD-Maker’s DVD Support 
You can copy or create DVD-ROM discs using CD-Maker. DVD operations within CD-Maker are 
very similar to CD based functions with the obvious exception that the target media is a DVD disc of 
one of the supported formats. Simply select your supported DVD burner just as you would a CD 
burner in the Copy or Data DVD functions. Use the Copy function to copy your data DVDs or the 
Data DVD function to create a DVD ROM. It may be possible to copy other types of non-copy-
protected DVD discs. CD-Maker’s Copy function will not all you to make copies of copy-protected 
DVD Video discs. 

Beginning with this release, most of CD-Maker’s tools and utilities now work on supported DVD 
drives. Generally speaking, all operations are very similar to their CD based counterparts. Any significant 
difference will be noted in the appropriate section of the NTI Utilities Guide. 
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Supported DVD Formats 
You can copy or create DVDs of the following formats:  

• DVD-R  
• DVD+R 
• DVD-RW  
• DVD+RW  

System Requirements 
Please check the following system requirements before installing NTI CD-Maker. 

H A R D W A R E  R E Q U I R E M E N T S  

• IBM PC or compatibles Pentium 266 or higher. 
• Minimum 64 MB Main Memory (128 MB Recommended). 
• 35 MB of available disk space, (90 MB required if Microsoft’s DirectX is required to be 

installed – See the notes below for additional information.) 
• NTI-supported CD or DVD recorders. We are continuously adding support for new 

CD/DVD recorders. Please visit our web site at www.ntius.com for the latest list of 
NTI-supported CD/DVD recorders. 

It is important that your system meet the above requirements. If you have questions, please contact 
NTI for further information. 

S O F T W A R E  R E Q U I R E M E N T S  

• Microsoft Windows 95, 98SE, ME, 2000, XP, or Windows NT 4.0 Service Pack 6 or later. 

O P T I O N A L  

• AVI to MPEG Encoder Tool requires Microsoft DirectX Version 8.0 or above. 

Notes: 

0 Certain new features like the AVI to MPEG Encoder tool require the additional installation of 
specific Microsoft Multimedia components like DirectX. In some cases, these components 
are not available for certain versions of the Windows® operating system. In these situations, 
the specific feature may be disabled or only offer limited functionality. Where possible, we will 
include these components on your CD-Maker installation CD or you may be required to 
download these components from the appropriate Microsoft download site should you wish 
to use the corresponding feature. We strongly advise you to visit these download sites and 
determine if these components are suitable for your system. 

0 The installation of additional components like Microsoft’s DirectX may place additional 
requirements on your hardware and installed software. Please consult the support site for 
these components before installing a component to make sure that your system meets these 
requirements. In some cases, like DirectX V8, the components cannot be uninstalled without 
a complete reinstallation of the Windows® operating system! 
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Installing NTI CD-Maker 
To install NTI CD-Maker you will need approximately 35 MB of free hard disk space. An automated 
SETUP program is provided to guide you through the installation. The default target directory (the 
directory where CD-Maker resides) is “C:\Program Files\NewTech Infosystems\NTI CD-Maker”. 
The setup program will walk you through the installation process. 

ª To install NTI CD-Maker: 

1. Close all programs, including virus-protection applications, and return to the 
desktop. 

2. Insert the NTI CD-Maker CD into the appropriate drive. When the drive starts up, 
the NTI CD-Maker installation screen will appear. 
³ Note: 

If the NTI CD-Maker installation screen does not appear, click Start and 
choose Run. Type D:\Install.exe in the Open: field, where D represents 
the letter of the drive in which the CD has been inserted. (If the drive is 
represented by a different letter, use that letter when typing the 
information in the Open: field.) 

3. Click Install NTI CD-Maker to begin the installation. 
4. At the Welcome screen, read the information and then click Next. 
5. Read the NTI License Agreement and click Yes to accept the terms and to 

continue, or No to cancel the installation. 
6. In the User Information window, enter your name and company (optional), and 

then click Next. 
7. In the Choose Destination Location window, read the information and click Next 

to continue. (If desired, click Browse to install NTI CD-Maker to a folder different 
from the Destination Folder that is shown.) 

8. In the Select Program Folder window, read the information that is presented and 
click Next. (If desired, a different folder can be used or created.) 

9. NTI CD-Maker Platinum will now be installed. 
10. You’ll be asked to restart your computer.  Select either option to continue and click 

Finish. (The recommended choice is "Yes, I want to restart my computer now.") 
11. After the computer restarts, re-launch any virus-protection programs that were 

closed before the program was installed.  Launch NTI CD-Maker from the 
Desktop or the Start menu. 

Notes: 

0 For Windows® NT, Windows® 2000 and Windows® XP, you must log in as a 
user with Administrator Rights to install NTI CD-Maker. 

0 For Windows® NT, Windows® 2000 and Windows® XP, you must restart 
your computer after installing NTI CD-Maker. 
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Warning! 
The AVI to MPEG encoder requires that Microsoft’s DirectX, V8.0 or above, be installed on your 
computer. The setup program will test for the existence of the proper version of DirectX and warn you 
if it is not available. You will be offered the opportunity to download and install it should you choose to 
do so.  

The AVI to MPEG encoder will have limited support for different AVI file formats until you install 
DirectX on your machine. You will not need to reinstall CD-Maker should you decide to install DirectX 
later. We highly recommend that you visit Microsoft’s DirectX web site 
(http://www.microsoft.com/windows/directx) should you have any questions regarding DirectX 
or its installation. 

Notes: 
³ Windows 95 users will need to download and install the DirectX Version 8.0a runtime 

package. Windows 98/Me and 2000 users should install the DirectX Version 8.1 runtime 
package. 

³ The AVI to MPEG encoder is not fully functional under Windows NT. This feature requires 
DirectX Version 8.0 or above, to provide support for AVI files that contain compressed 
audio or video streams. However, DirectX Version 8 is not supported on the Windows NT 
platform and therefore the AVI to MPEG encoder may not support many types of AVI files. 
CD-Maker will warn you should you try to convert an unsupported AVI file. You can include 
support for additional AVI file types by downloading and installing Microsoft’s DirectX 
Media Runtime V6.0 on NT based systems. 

Web Resources 
NTI is committed to your success! We hope to make your experience with NTI CD-Maker the best 
possible by making available news and information, product updates and upgrades, Frequently Asked 
Questions and our Technical Support from the Internet. Be sure to visit our web site is at 
www.ntius.com. 
Company or Product News and Information 
Find out the latest about what we are doing at www.ntius.com/corporate/inthenews.htm or any of 
our world-class products at www.ntius.com/products/index.htm. Learn about the latest features or 
supported drives for your NTI CD-Maker software. You can even download a trial version of any of 
our products directly from our web site giving you the easiest way to give our software a test drive 
before you buy. 

Frequently Asked Questions (FAQs) 
You can browse the latest information and commonly asked questions about CD-Maker from our web 
site at s www.ntius.com/faq.htm. Find out what questions other CD-Maker users had about it. Get 
quick answers to the most commonly asked questions. 
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Updating your NTI CD-Maker Software 
From time to time, we release product updates and upgrades from our web site. Product updates 
generally contain patches and other corrections to your CD-Maker software and are available for 
registered users to download from our web site. Upgrades involve major product enhancements along 
with patches to reported problems. They will also be available for download but may involve a nominal 
fee.  

Updates can be installed by executing the downloaded file. All updated files and patches will be applied 
to your CD-Maker software automatically! It is highly recommended that you download and install any 
updates prior to contacting our Technical Support Department. 

Visit our web site at www.ntius.com/download/index.cfm for the latest updates for all NTI 
products! 

Updating the Supported Drive Database 
We frequently add support to new drives to our drive support database. You can use our Live Update 
feature to download and automatically install the latest drive support database on your system. Click the 
Live Update item on the Tools Menu to use Live Update to download the latest database from our 
servers.  

Notes: 
³ You must be online to use the Live Update feature. 

³ Live Update may not be available on all CD-Maker products. 

Contacting Technical Support 
Many different types of on-line help are available with NTI CD-Maker within the specified applications.  
You can browse through the CD-Maker Help file to become familiar with all the features available 
within that application. 

You can also use context-sensitive help to display information about specific commands, dialog boxes, 
and other window elements. 

Help and information on the latest upgrades as well as a Technical Forum on Frequently Asked 
Questions (FAQs) can be found on our web site (www.ntius.com/support). 
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Getting Started 
In this Chapter, we will show you how to build, edit, validate and record a virtual image to a CD/DVD 
disc. 

Before we start, let’s go over a few important concepts related to the above procedure. 

What is a Virtual CD Image (CD Layout)? 
A virtual disc image is a simple database file that contains information about the files to be recorded on 
the target disc. It contains pointers to the file(s) that you want to record on the new disc.  These pointers 
tell CD-Maker where to find the actual files and folders on your system. The actual contents of these 
files or folders are still on the original storage media. In other words, without duplicating the content of 
any file, a virtual disc image, or layout file, maintains and contains a file structure and information about 
where each file resides. The image is “virtual” since it does not contain the actual file or its contents. 
Using this “virtual” image scheme effectively cuts your hard disk space requirement in half. We use the 
terms virtual CD image and CD layout interchangeably throughout this guide. 

This explanation may seem complicated but the important parts here are:  

1. A virtual image contains information about the selected folders and files to be 
recorded. 

2. It allows you to easily create multiple CDs/DVDs that contain the same data but 
recorded in different formats. 

3. It saves hard disk space. 

File Name Restrictions 
CD-Maker gives you the following options for the File Name: 

• ISO 9660 Level 1 compliant MS-DOS names (8+3 restricted character set) 
• MS-DOS file names (8+3) 
• Joliet MS-DOS (8+3) and Windows 95, up to 64 characters 
• Romeo, Windows 95 Long filenames up to 128 characters. 
• UDF 1.5, filenames up to 255 characters. 

ISO 9660 File Name Restrictions 
Since a CD-ROM disc was designed to be read across various platforms, such as PC, Mac and UNIX, 
the ISO 9660 standard is very restrictive on file and folder names. The allowable characters for file and 
folder names are A-Z, 0-9 and _. ISO 9660 also restricts the subdirectory name and the depth of 
subdirectories to eight levels. 

MS-DOS File Names 
All MS-DOS file names are valid under this option. If the disc recorded is for DOS, Windows 3.1 or 
3.11, then this option is recommended.  

Note: 

0 If you are working on Windows 95, some long file names may exist. In this case, if you choose 
the MS-DOS file name restrictions, you should vary the first eight characters of each file name 
so that every file name remains unique in MS-DOS format.  
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Joliet File Name Restrictions 
This file system is designed for use with Windows 95. It allows long file names. However, it still 
conforms to MS-DOS restrictions for short file names. If a recordable disc is created using this file 
system, the disc can be read back only under Windows 95 and/or Windows NT 4.0. 

Romeo  
Romeo is defined as Windows 95 long file names only, up to 128 characters. It is supported by all CD-
Maker software, Version 3.0 and above. If a CD is created using this file system, the disc can be read 
back only under Windows 95 and/or Windows NT 4.0. 

Universal Disk Format (UDF) 
Universal Disk Format (UDF) is a CD-ROM and DVD file system standard developed to ensure 
consistency among data written to various optical media, by facilitating both data interchange and the 
implementation of the ISO/IEC 13346 standard. UDF is required for DVD-ROMs, and is used by 
DVD to contain MPEG audio/video streams. Originally developed as a replacement for the ISO 9660 
file system, UDF is used by CD-RW in a process called packet writing that makes CD writing more 
efficient in terms of the time and disk space required. NTI’s FileCD packet-writing program offers both 
ISO 9660 and UDF support for CD-RW, DVD-RW and DVD+RW media. 

UDF supports a maximum volume size of up to 128 terabytes. The maximum file size is equal to the 
size of the volume containing that file. UDF allows up to 255 characters for a file name. 

Automatic file-name restriction checking 
NTI CD-Maker will automatically perform file-name restrictions checking during the Test writing and 
actual writing operations.  

This means: 

1. The CD-ROM image you create does not have to conform to any file name standard. It 
contains information about the original files and folders that reside on hard disk or floppy or 
CD-ROM drive. 

2. Before you start to record an image to the disc, CD-Maker will automatically validate the Data 
CD layout to follow your selected file name standards. 

This is a very useful feature. For example, you can create a virtual image and use it to record a 
CD/DVD following the ISO 9660 standard. Now you want to use the same virtual image to record a 
CD following the Joliet file system standard. With NTI CD-Maker, this is a snap!  
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Getting familiar with NTI CD-Maker 
When you launch the CD-Maker program the following opening screen is displayed: 

 

The opening screen displays the program selection dialog on one of four background bitmaps. To 
choose a program function, simply select it from the program selection dialog. Selecting Close from the 
File menu exits the current function and returns to the CD-Maker opening screen. 

The background changes at various times of the day. You can customize the existing background 
bitmaps or use your own. There are four preset times of day to choose from: Morning (5:00 AM – 8:00 
AM), Day Time (8:00 AM – 5:00 PM), Evening (5:00 PM – 8:00 PM) and Night Time (8:00 PM – 5:00 
AM). You can select the Background Pictures tab of the Options dialog (Tools Menu) to customize the 
CD-Maker backgrounds. 
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Select the Data CD function from the data menu to create a CD-ROM disc.  NTI CD-Maker displays 
the Data CD screen: 

 

Source 
Pane—Explorer 

View 

Destination 
Pane—Data 

Track Layout CD Info 
Bar 

The first thing that you will notice about CD-Maker is how it automatically customizes itself based on 
the type of CD you wish to create. Its intuitive Step Interface walks you through the recording process. 
The Layout Area is automatically configured when you select the function you wish to do. It is split into 
two panes. The upper pane is the Source Pane. It is used to locate the files and folders that you want to 
write to the new CD. In most cases, it will contain a Windows' Explorer View as shown above.  
The lower pane is the Destination Pane. It will display one of the following layouts: 

1. Data Track Layout – Contains information about the files and folders that make up a data 
track. It is used for Data CD/DVD, Mixed-Mode CD and CD Extra discs. 

2. Audio Track Layout - Contains information about the files that make up an Audio CD layout. 
It is used for Audio CD, Live Audio CD, Mixed-Mode CD, CD Extra and Custom CD discs. 

3. Video Track Layout - Contains information about the files that make up a video CD layout. It 
is used for Video CD discs. 

The source and destination panes may be resized horizontally by dragging the splitter bar between them. 
Dragging the splitter bar up will display more of the destination pane and reduce the visible portion of 
the source pane. 
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Step Interface 
CD-Maker’s new Step Interface guides you through the layout and recording process. Most disc types 
can be created in two steps. Step one — Create the CD layout image. Step two — Record the new CD. 
Mixed-Mode CD and CD Extra discs require a third step. These CD formats contain both a data track 
and an audio track.  NTI CD-Maker splits these into separate steps for ease of use. As you can see 
above, it is just a simple click of a button and you are on the next step of the CD creation process. 

New Toolbar & Menus 
The number of buttons and menu items has been significantly reduced in CD-Maker. This was made 
possible by the newer, more efficient design and operation of CD-Maker.  NTI CD-Maker automates 
most of the work required to create a CD. You simply drag-and-drop the files you want from the source 
pane to the destination pane, save your CD layout and then record your CD. It is that simple, just a few 
clicks of the mouse and you have a new CD. Anyone familiar with standard Windows programs like 
Find and Explorer will instantly feel at home with NTI CD-Maker. 

The CD-Info Bar 
The CD Info Bar displays the amount of space used by the current CD layout. It displays usage in 
minutes for Audio and Video CD layouts and in MegaBytes (MB) for Data CD layouts. It provides a 
quick visual queue showing you the amount of space used as you add files to the current CD layout.  

Using the Source Pane 
As mentioned above, the source pane will be used to identify the information to be recorded on the 
destination CD. In most cases, you will use a Windows Explorer view to locate the files to be copied. 
Once identified, you simply drag the files/folders and drop them on the destination pane. It's that easy! 

Using the Windows Explorer pane 
The Explorer pane is split vertically into two panes. The left pane displays the system resource tree while 
the right pane displays information about the item selected in the resource tree. Generally, the right pane 
displays the files and folders contained in item selected in the resource tree. The two panes may be 
resized vertically by dragging the splitter bar between them. Dragging the splitter bar to the left will 
display more of the file information in the right hand pane while reducing the visible portion of the 
resource tree in the left-hand pane. 

The information pane has four columns displaying the file/folder name, its size, the file type and the last 
modified date. The files may be sorted on any one of these columns by clicking on the column header. 
By default, files are sorted alphabetically (ascending) by name. Click the Name column heading to sort 
them in descending order by name. Click it again and the files are now sorted in ascending order by 
name. 

Notes: 
³ CD-Maker’s explorer pane will display both the audio tracks and data files/folders found on a 

CD-Extra or Mixed-Mode disc is inserted in a CD drive on your system. 

³ For data track layouts, the destination pane will also have a resource tree pane and file 
information pane that resembles the Explorer view found in the source pane. Items can be 
dropped on either pane and positioned accordingly. For Audio or Video CDs, there is no 
resource tree pane. Items dropped into the destination pane will be added to the end of the 
list. You can move them up or down the list by dragging and dropping them where you want 
them in the track list. 
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Using Layout Filtering 
CD-Maker’s layout filtering allows you to select the type of files you would like to view in the Explorer 
pane. In many layouts, the filters are fixed based on the type of CD you are creating. For instance, the 
Audio CD layout’s filtering is set to only display CD-DA tracks, MP3, WAV and WMA audio files. This 
makes sense given that CD-Maker only supports these file types when burning an Audio CD. 
However, let’s say that you want to copy your mp3 collection onto a CD or DVD-ROM. You can do 
this simply by setting the data layout filter to *.mp3 and then use the Explorer pane to locate and drag 
them into your Data CD/DVD layout. 
Note: 
³ You can set the layout filters for all layout types from the File Types Tab in the Options dialog. 

Using the Destination Pane 
For data tracks, the destination pane mirrors the source (Explorer View) pane and operates in much the 
same manner. You can Drag and drop files/folders to new positions within the CD layout image, create 
new folders, rename or even delete files and folders. It is important to remember that moving, renaming 
and deleting files from the destination pane only impacts the CD layout and not the original 
files/folders on your system. These changes will only affect the file names and directory structure of the 
virtual CD image and any subsequently recorded CD. If you rename a file in the destination pane, the 
resulting CD will use the new name while the original source file name is not changed on the source 
device. 
Similar to the Explorer view found in the source pane, the left pane of the data track layout contains a 
resource tree. The resource tree works just like the tree found in Windows Explorer. You can expand or 
collapse branches with the click of your mouse. Files and folders can be moved with a drag and drop 
operation. You can add a new folder to your layout or access Cut, Copy, Paste and other frequently 
used functions through a shortcut menu activated by a click of your right mouse button.  
The right-hand pane is an information pane similar to that found in the Explorer View. It has six 
columns displaying the file/folder name, its size, the file type, last modified date, status and it’s source. 
The files may be sorted on any one of these columns by clicking on the column header. By default, files 
are sorted alphabetically (ascending) by name.  
As mentioned above, the Audio and Video Track layout panes do not contain a resource tree. Instead, 
they have a single pane to drop files. By default, new files are appended to the Track List found in the 
destination pane. Once dropped onto the destination pane, they can be re-ordered in the track list with 
the mouse. Simply select the track to move and drag it to the new position in the list.  

Step 1 — Creating a Data CD Layout 
Opening a new Data CD or DVD layout 
The Data CD layout can be used to create CD-ROM or CD-ROM XA discs. DVD-ROM discs are 
made from the Data DVD layout.  

ª To open a new Data CD or DVD layout file: 

1. Click the Data icon on the Home Screen. 
³ Note: 

If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Data CD or Data DVD from the Data Menu. 
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Setting the Volume Information  
Volume information is located in the CD Layout Properties dialog box. To change it you must select 
the CD Layout Properties item from the File menu and select the Volume tab. 

 
The ISO 9660 Standard allows you to describe certain information about the CD. Such information is 
called the Volume Description, and will be recorded on the CD. The following briefly explain the fields 
in the Volume Description. 

• Volume Name 
You can specify an identification of the volume in this field. It allows up to 32 alphanumeric 
characters, which include 0-9 and A-Z. This field is recommended. 

• Volume Set Name 
If the disc you are preparing is part of a set of discs, every disc in the set may have the same 
name recorded in this field. It allows up to 32 d-characters. This field is optional. 

• System Name 
It refers that the operating system under which the application will run. It allows up to 32 a-
characters. This field is optional. 

• Publisher Name 
You can identify the publisher of the disc. It allows up to 128 a-characters. This field is 
optional. 

• Data Prepare Name 
You can specify an identification of the person or other entity, which controls the preparation 
of the data to be recorded on the volume. It allows up to 128 a-characters. This field is 
optional. 
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Date & Time 

 

Specify the below Dates and Times of this CD volume. 

• Creation 
You can specify the date and the time of the day at which the information in the volume was 
created. 

• Modification 
You can specify the date and the time of the day at which the information in the volume was 
last modified. 

• Expiration 
You can specify the date and the time of the day at which the information in the volume may 
be regarded as obsolete.  

• Effective 
You can specify the date and the time of the day at which the information in the volume may 
be used. 

Saving the new layout file  
We strongly recommend that you save your work frequently enough to avoid loss of data in case of a 
system crash. 

ª To save your Data CD or DVD layout file: 

1. Choose the Save command from File menu. 

                                                      or 

2. Click on the save button  on the toolbar.  
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Building a Data CD or DVD layout 
To build your Data CD or DVD layout you will need to import files and/or folders from the source to 
the layout file. Importing files is easy with NTI CD-Maker. There are two basic ways to import files into 
your layout. 

Using the Add File method 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Edit menu. When selected, CD-Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 

Using the Explorer View (Drag-and-Drop) 
As discussed above, CD-Maker will display an Explorer view when creating or editing a Data CD or 
DVD layout. From this view, you can select the files or folders you wish to import and drop them to 
the desired position in the data track layout.  

ª To Add a file/folder to the layout: 

1. Navigate the resource tree to locate the desired file or folder. 

2. Click on the desired file or folder. 

3. Hold the mouse button down while dragging the selection to the destination pane. 

4. Release the mouse button to drop the selected file/folder in the destination layout. 

Editing a Data CD or DVD layout 
A saved data layout may be edited at any time in CD-Maker. Files may be added, deleted or moved 
around during the editing of your layout.  
Note: 
³ The following editing commands have no effect on the original files (or folders) on your hard 

disk. However, they do change the layout itself, and consequently, any CD-ROM or DVD-
ROM discs created from the edited layout. 

Moving a File or Folder 
Files and folders can be moved to any location in your Data CD or DVD layout with a simple drag and 
drop. Select a file or folder to be moved by clicking the left mouse button and then, while holding the 
left button, drag the file to a new home folder and drop it by releasing the left button. The selected file 
or folder will be moved and displayed in its new location in the Resource Tree of the data track layout. 

ª To move a file or folder in the data layout: 

1. Select the file or folder to move. You make this selection from either Resource Tree 
or Information Pane of the Data Track Layout. 

2. While holding down the left mouse button, drag the selection to the desired location 
in the Resource Tree. 

3. Drop it in the new location by releasing the left mouse button. 

Note: 
³ NTI CD-Maker highlights the home folder as you drag the folder on top of it. 

The selected file or folder will become a branch of the highlighted folder. 
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Copying a File or Folder 
You can copy selected files or folders to any folder in your Data CD or DVD Layout.  

ª To copy a file or folder in the data layout: 

1. Select the file or folder to copy. You make this selection from either Resource Tree 
or Information Pane of the Data Track Layout. 

2. While holding down the left mouse button, drag the selection to the desired location 
in the Resource Tree. 

3. Press the Ctrl key while dragging the selection to the new location. 
4. Drop it in the new location by releasing the left mouse button. 
Notes: 

³ NTI CD-Maker highlights the home folder as you drag the folder on top of it. 
The selected files or folders will be copied to the highlighted folder. 

³ The copy and paste functions are also available from the toolbar and the Edit 
and Quick Command Menus. 

Deleting a File or Folder 
You can delete selected files or folders from your Data CD or DVD Layout.  

ª To delete a file or folder from the data layout: 

1. Select the file or folder to delete. You make this selection from either Resource Tree 
or Information Pane of the Data Track Layout. 

2. Click Delete on the CD-Maker toolbar. 
3. Click Yes to confirm the deletion. 
Note: 

³ The delete function is also available from the Edit and Quick Command 
Menus. 

Renaming a File or Folder 
You can rename selected files or folders to any folder in your Data CD or DVD Layout.  

ª To rename a file or folder in the data layout: 

1. Select the file or folder to rename. You make this selection from either Resource 
Tree or Information Pane of the Data Track Layout. 

2. Choose the Rename item from the Edit Menu.  Alternatively, right-click your 
mouse and choose Rename from the pop-up menu. 

3. Enter the new name. 
4. Press the ENTER key to complete the operation. 
Notes: 

³ Hitting the Escape key will exit the rename operation and leave the name 
unchanged. 

³ The rename function is also available from the Quick Command Menu. 
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Viewing File or Folder Properties 
You can view the properties for any file or folder in your layout. In the Properties Dialog Box, you will 
see the name, path, size, MS-DOS name and created & modified date of the selected file or folder. If 
you want the file (or folder) to be hidden, you can choose to hide it by checking the corresponding 
check box; otherwise, you should leave the box unchecked. 

 

ª To view the properties of a file or folder in the Data CD or DVD layout: 

1. Select the desired file or folder. You make this selection from either Resource Tree 
or Information Pane of the Data Track Layout. 

2. Click Properties on the CD-Maker toolbar. 

3. Click OK to close the Properties dialog and save any changes you may have made. 

Note: 
³ The properties function is also available from the Edit and Quick Command 

Menus. 
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Step 2 — Writing a Disc 
Once you have prepared your Data CD or DVD layout, you can perform the writing (recording) to a 
disc.  NTI CD-Maker allows you to test the creation of your CD in two ways. First, CD-Maker will 
validate your layout. It checks to see if the files and folders listed in your layout exist on the source drive. 
If a file is not found then you will be prompted for what to do. This validation step occurs just before a 
test or actual recording of your layout to the CD-Recorder. 

NTI CD-Maker also will let you do a test recording or simulation of your layout before an actual write is 
attempted. It is a good idea to run this test before creating a CD/DVD-ROM. Once the layout has 
been verified and a test write successfully completed then it is time to write your new CD/DVD. 

Setting the Data CD or DVD Layout Properties 
The Data CD Properties dialog allows you to set the following: File Name Restrictions, Data Format, 
Volume Info and Data & Time. These field definitions will be used to validate your data layout to the 
selected standard and format and make it ready for recording. By default, CD-Maker sets these fields to 
the Joliet file name restriction, CD-ROM Mode 1 and Original file date and time, respectively. 

File Name Restrictions 

 
Different file systems have different restrictions on file names.  NTI CD-Maker provides you with the 
following options for the file system. 

• ISO 9660 standard, level-1 

If you need the disc to be readable on different platforms, you have to choose this command 
to standardize all the file and folder names according to the rules of ISO 9660.  

Since the CD-ROM disc is designed to be read across various platforms such as PC, 
Macintosh O/S and UNIX, ISO 9660 is very restrictive in its naming characteristics of files 
and folders. The allowable characters for file and folder names are A-Z, 0-9 and _. ISO 9660 
restricts the extension to three characters and the depth of subdirectories to eight levels. 
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y MS-DOS file names  

If you are certain that the created CD-ROM disc will be used only in a DOS or Windows 3.1 
or 3.11 environment, you can choose this option. 

y Joliet  

If the recorded CD will be used on Windows 95 only, in order to resolve the ISO9660 
restrictions and make long file names that can be fully read back, you should follow Joliet file 
name restrictions. 

y Romeo  

If a recorded disc is created using this file system, the disc can be read back only under 
Windows 95 and/or Windows NT 4.0. 

y UDF (Universal Disk Format Version 1.50) 

UDF supports a maximum volume size of up to 128 terabytes. The maximum file size is 
equal to the size of the volume containing that file. UDF allows up to 255 characters for a file 
name. 

Data Format 

 
You should set the Data Format of your CD-ROM disc to either CD-ROM Mode 1 (CD-ROM) or 
CD-ROM Mode2 (CD-ROM XA) or select DVD-ROM to create a Data DVD. You can select the 
data format from the Data CD Properties tabs or directly from the Data CD Layout. 

Note: 
³ This option is preselected for Data DVD layouts and set to CD-ROM for a Data CD layout. 

You cannot select the DVD-ROM option from a Data CD layout.  



M A K I N G  A  D A T A  C D  O R  D V D  

Making A Data CD or DVD 30 

Write CD Options 
NTI CD-Maker displays the Write CD dialog when you attempt to record a CD/DVD.  You may 
choose to Test (Simulated Recording), Test & Write or Write operation. You may also select the 
Writing Speed and the number of Copies from this dialog. The writing method may be selected from 
the Advanced section of the Write CD dialog. The following is a brief description of the Write CD 
dialog and all associated options: 

 
Write Options 
The following options are available from the Write CD dialog: 

Test  

Perform a test recording of the current layout to your CD/DVD Recorder. This option writes all 
data exactly as it would during the actual writing process except the recorder does not write the 
incoming data to the media. All settings, except for Copies are utilized in the simulation process. 

Test & Write 

Perform a test simulation and upon successful completion write the data to the media. All settings 
are utilized during this operation. 

Write 

Writes the current layout to the CD-R, CD-RW or DVD media. All settings are utilized during a 
write operation. 

Speed 

Select the recording to be used in the Test or Write operation. The combo box will list all writing 
speeds supported by the selected CD/DVD recorder. 

Copies 

Specify the number of copies of the current layout will be written. This setting is not used during 
the Test operation. 
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Volume Balancing 

Determines the average volume level of all the tracks in your layout and then adjusts the volume of all 
tracks to that level as they are being written on your Audio CD. This feature creates an Audio CD with 
all tracks recorded at the same volume and eliminates the need to constantly adjust the volume level on 
your CD player to compensate for differences in volume levels in your source audio files.  

Notes: 
³ This option is only available when burning an Audio CD 

³ This feature can add several minutes to your recording time but can be disabled by 
unchecking it in Write CD dialog. By default, this box is set according to the Preferences Tab 
in the CD-Maker Options dialog. 

Write CD Text 

Enables the writing of CD Text information to your Audio CD. 

Note: 
³ This option is only available when burning an Audio CD.  Your recorder must support the 

writing of CD Text (See the Write Tab of the Drive Properties dialog to verify your drive’s 
capabilities.) 

Buttons 
Start – Begin the selected operation. 

Cancel – Exit the Write CD dialog without executing any operation. 

Advanced 

Displays the Advanced Write CD options. 
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Write Method 
NTI CD-Maker supports the following writing methods: 

Smart decision 

NTI CD-Maker automatically selects the writing method based on the type of CD/DVD you are 
going to write. This is the default selection and the best choice in most cases and is indicated by a 
blue checkmark to the right of the selected writing method. 

Track-At-Once 

Track-At-Once writing mode will write one track at a time.  NTI CD-Maker will copy from the 
original source to the program cache buffer first, and then send them from the program cache 
buffer to the CD/DVD recorder, which in turn writes to the target disc all on one track. Select one 
of the following choices to tell CD-Maker if you wish to leave the session and disc open or closed 
at the end of the writing process: 

1. Close session, leave disc open – Closes the session but does not finalize the disc at the 
end of the write operation. 

2. Leave session and disc open – Does not close the session or finalize the disc at the 
end of the write operation. 

3. Close session and disc – Closes the session and finalizes the disc at the completion of 
the write operation. 

Session-At-Once 

Session-At-Once writing mode will write all data from a single session at one time.  NTI CD-
Maker will copy all source tracks from the original source to the program cache buffer on the hard 
disk first, and then send them from the cache buffer to the CD/DVD recorder.  

Disc-At-Once 

For Disc-At-Once writing mode, it is required that all the source tracks must be on the hard disk. 
If you want to make a master disc, you must use Disc-At-Once writing mode. 

Validating the Data CD or DVD Layout 
NTI CD-Maker automatically validates your layout before a write or simulation test is performed. 
Remember that a virtual image consists of pointers to the source files on your hard disk.  If any changes, 
such as rename, delete, or move has occurred to the actual source files, the pointers in the virtual image 
are no longer valid. 

NTI CD-Maker also validates source files from network or removable media. Validation is necessary 
because once the recorder starts recording, if any problem occurs, it may ruin the whole disc. 
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Test Writing a disc (Simulated Recording) 
Simulated recording is the last step before the actual recording of your layout. To do this, you must have 
a CD or DVD recorder connected properly to your system in with a piece of media inside. The Data 
CD Properties must have been completed before attempting a test simulation. 
During a simulation, just as in actual recording, CD-Maker will transfer all the data to the recorder, 
however unlike actual recording, the CD/DVD-recorder will not actually record the data to the disc. 
Some older CD-recorders do not support such test simulations—in that case, you will not be able to 
perform this test. 

ª To perform a test simulation: 

1. Click the Step 2 button from the layout area to display the Write Disc dialog box.  

2. Check Test or Test & Write from the Write dialog box. 

3. Select the Writing Speed, Number of Copies and any desired Advanced options 
from the dialog box. 

4. Click Start to begin simulated recording. 

Notes: 

³ Selecting Test & Write will automatically begin the recording of the CD/DVD 
once the test simulation has successfully completed. This is the default 
selection in CD-Maker. 

³ NTI CD-Maker can be set to automatically lower the writing if errors are 
encountered during the testing process. This ensures that your CD/DVD is 
created using the fastest writing speed available to you. See the Preference Tab 
of the Options dialog (Tools Menu) to this setting. 

³ The number of copies entry is not used for a test simulation but be sure to 
make this setting if you are using the Test & Write option above. 

When simulated recording is in progress, a status panel will display how much of the recording has been 
completed. Test mode will also be indicated with a green indicator next to the Cache level display. Once 
you successfully finish the simulation, it is time to make your own CD/DVD.  

Writing a Data CD disc 
After a successful simulation, you can write to the disc. The steps to write your CD/DVD are the same 
as those listed above for a test simulation. You must either select the Test & Write or Write option from 
the Write dialog box. Review the other settings and click Start to record your new disc. Write mode will 
also be indicated with a red indicator next to the Cache level display. 

Summary 
This chapter has shown you how to use CD-Maker to create your own CD-ROM disc. The instructions 
are intended for new users.  

Once you are familiar with these basic steps, you may want to explore other topics covered in the next 
chapter, “Supplement to Creating a CD-ROM disc”.  
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Chapter 4 — Topics of discussion 
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File Compare Utility  
 
Temporary Files 
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Multisession Recording 
What is a Session? 
A CD-ROM disc can contain many sessions (up to 99), where each session can hold up to 99 tracks. A 
session is a set of data that is written in a single operation. 

The physical components of a session include a lead-in, data, lead-out, and a Table of Contents, which is 
called a TOC. 

There is 23 MB of overhead (information written to the CD recordable disc by the CD file system) 
between the first and second session and 14 MB of overhead between each subsequent session. 
Therefore, the more sessions you make on your CD-ROM disc, the more overhead you will incur. 

What is Multisession? 
A multisession disc contains more than one session, on a single disc. There are two types of 
multisession discs: Incremental Multisession, and Independent Multisession. 

Incremental Multisession 
Since CD-ROM discs are write-once and read-only, there is a misconception that it is impossible to do 
any modification to the old contents of a CD-R disc. This is wrong—it is indeed possible on the file and 
directory structure level. The key to solving this problem is Incremental Multisession Recording. 

Suppose you do incremental backups on a disc, very often you want to modify a file (or directory) in the 
last session and in the meanwhile import some other new files from your hard disk. To do this, you can 
do a multisession import. You can retrieve the last session from the CD into your CD layout; import 
new files from the hard disk and then do the required editing. With this new virtual image, you can, in 
effect, re-edit files in the last session; for example, you can delete, copy, move and rename files. After 
everything is done, you can record the image to your disc as a new session. 

This new session will contain (1) information (referred to as file pointers) about the last session where 
the old files actually reside within that session and (2) the new files you have just imported from the 
hard disk. The new Path Table and directory files in the new session will be updated according to your 
editing. For example, while editing your new CD layout, you deleted various files and/or folders that 
were included in the last session of the existing CD. Once you record the new image to the disc, the 
new updated Path Table and directory files will not contain any information about those files and/or 
folders that have been “deleted” from the image.  

By default, most CD-ROM drives will only access the last session of a CD-ROM disc. Through 
information contained in each session, starting from the last session, you will be able to access old files 
recorded in the previous sessions on the disc. 

The basic idea in Incremental Multisession is to use pointers in each session to link all the sessions 
together; these links enable you to access the latest information starting from the last session on the disc. 
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Independent Multisession 
The difference between incremental multisession and independent multisession is that each session in 
an independent multisession disc is not linked back to a previous session in any way. The idea is to 
organize multiple sessions as completely separate volumes, each with its own directory of information. 

Your CD-ROM drive must be capable of reading independent multisession discs. Most CD-ROM 
drives  (as of this writing) are only able to read either the first or the last session from the disc without a 
special driver or "session explorer." 

An independent multisession disc can be transformed into an Incremental Multisession disc by 
importing these two sessions into your CD layout when you create your third session CD image.  NTI 
CD-Maker allows you to import more than one previous session from the disc. CD-Maker 
automatically asks if you wish to import a previous session found on the target disc. 

How To Use It 
With NTI CD-Maker, you can create both Incremental and Independent Multisession discs.  

Incremental Multisession  
You can import multisession at any time as long as your CD Recorder is connected and contains a disc 
that has at least one session on it. CD-Maker automatically senses any sessions recorded on a disc. If 
you have a CD in your CD-Recorder when you attempt to import files into a new Data CD layout, CD-
Maker will advise you of the existence of recorded sessions on the current disc and ask if you wish to 
import them into the current CD layout. If you say yes, all sessions on the existing CD are automatically 
imported into the current layout and any data written to the CD will be treated as an incremental 
multisession recording. If you say no, previous sessions are not imported and data written to the disc 
will be treated as an independent multisession recording. 

Independent Multisession 
As mentioned previously, to create an independent multisession disc, you do not need to import 
anything from the existing CD-R disc. Answer “No” at the prompt, then simply prepare your layout 
from the source hard disk, and then write to the CD-R disc.  NTI CD-Maker will create an independent 
session on the current disc. 

OverburningTM 
Overburning allows you to burn a CD that contains more data than is normally possible on a standard 
CD. It is only supported on certain CD recorders and only works when you use the Disk-At-Once 
(DAO) writing method. 

There are many uncertainties when overburning a CD. It is even possible that your CD recorder can be 
damaged in the process. Additionally, you may experience read or write errors at the end of the disc or 
other SCSI/ATAPI command failures.  

There is no way to automatically determine how much additional capacity will be available on your CD 
recorder. In some cases, you may be able to write up to 78:00.00 but you might want to stop at 76:30.00 
if you do not know the overburn capacity of your CD recorder. 

 
Warning!!! 

 
The use of this option is always at your own risk! We cannot guarantee its success or that damage 
will not occur to your recorder!!! 
 



S U P P L E M E N T  T O  M A K I N G  A  C D - R O M  D I S C  

Supplement to Making A CD-ROM Disc 39 

Ninety-Nine Minute Media 
Beginning with Version 5.0, NTI CD-Maker now supports the writing to ninety-nine (99) minute CDs 
under certain conditions. These CD-R discs use a tighter spiral and when combined with Overburning 
it is possible to achieve recording capacities up to ninety-nine minutes. It must be noted that only a very 
few drives can actually reach the ninety-nine minute limit and then only at the slower writing speeds of 
2x or possibly 4X. In fact, many drives will not record beyond ninety minutes and again, the vast 
majority of drives do not recognize ninety-nine minute media at all. This is because this media is 
completely outside of the Red Book specification. If you are not able to use eighty-minute media then 
you are not likely to be able to use the ninety-nine minute media either. 

Again, there can be many problems when using this type of media. In addition to the lack of support by 
most drives, many problems can be encountered when trying to play a ninety-nine minute CD as well. It 
will be up to you to find the best combination of media, recorder and player should you decide to use 
the ninety-nine minute media. 

Erasing a Rewritable Disc 
You can erase your CD-RW media directly from the CD-Maker Tools Menu. You can choose either a 
Quick Erase or Full Erase. The quick erase function overwrites the existing table of contents, thus 
reducing the time it takes to erase a CD-RW disc to just a few minutes. The full erase function erases all 
data on the disc and takes a considerably longer amount of time to complete. A full erase however 
restores the CD-RW media to a more reliable state. 

ª To erase a CD-RW disc: 

1. Select the Erase Rewritable Disc… item from the Tools Menu. 

 
2. Select the CD-RW drive that contains the CD-RW media that you would like to 

erase from the CD-RW Drive list. 
3. Select either Quick or Full for the Type of erase option. For reliability reasons, it is 

recommended that you choose the Full erase option. 
4. Click Start to begin erasing. 
Notes:   

³ Erasing a DVD-RW disc is similar to a CD-RW. A full erase on a DVD-RW 
will take longer due to its increased data capacity.  

³ Erasing a DVD+RW disc will only over-write certain data areas rendering all 
existing data on the disc unreadable. 
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Disc Info & Tools 
You may wish to check information about a disc before you decide to import any session from the CD-
ROM disc. To do this, choose the Disc Info & Tools command under the Tools menu. The “Disc Info 
& Tools” dialog box will appear. 

This box contains informational fields about the disc, including its Medium Type, Capacity, Free Space. 
Status, and other details as shown below: 

 
 
Disc Type 

The disc type can be one of the following: (1) CD-DA or CD-ROM disc; (2) CD-I disc; (3) CD-ROM 
XA disc. 

Disc Status 

1. Blank Disc: a blank CD-R disc.  

2. Recordable Disc: not a blank disc but you can still use this disc to record. That means the disc 
has not been finalized yet. 

3. Unrecordable Disc: either a conventional CD or Disc-At-Once CD-R disc. You cannot use 
this disc to record. 

Disc Capacity 

This field indicates the total recordable capacity of the disc, as expressed in the “minutes: seconds: 
frames” format. If you insert a CD disc, this field will show you the exact capacity of the data stored on 
the disc. 
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Free Space 

This field shows the free and available space on the disc, as expressed in “minutes: seconds: frames”. If 
you insert a finalized or silver disc, this field will be zero, indicating no free space. 

Buttons  

1. Refresh: When you insert another CD, click this button to display updated information about 
the new CD. Or, when you want to make sure that the contents of the currently inserted disc 
are correctly displayed, click on the Refresh button. 

2. Close Session: If there are sessions that have remained open, when you highlight the 
unclosed session, the Close Session button will be enabled. You can use this to close that 
session. Usually, there are two possibilities that resulted in a session remaining open: (a) an 
error occurred during actual recording, in which case the session most likely would remain 
open; (b) you chose the “Leave session and disc open” option for the Track-At-Once writing 
method, which is in the Advanced section of the Write CD dialog box. 

3. Recover: If the track is damaged, when you highlight the damaged track, the Recover button 
will be enabled. Highlight the damaged track and click on this button to recover it. The 
recover utility is available only when your CD-Recorder supports this function. 

4. Read Track: You can read a track from CD/DVD. Highlight a track you want to copy to 
your hard disk, and then click on the Read Track button. The following dialog box will pop 
up. 

                
NTI CD-Maker will read the selected track to the drive you specified and save it. 

5. Compare Track: You can compare a track from CD/DVD. Highlight a track you want to 
compare to your hard disk, and then click on the Compare Track button.  

6. Erase: The erase button will be enabled if the selected drive is a CD-RW device with CD-RW 
media. You can erase the CD-RW disc by clicking this button.  

7. CD Text…: Displays CD Text information about the CD in the selected CD recorder when 
clicked. 

8. Help: Displays help information for the Disc Info & Tools dialog when clicked. 

9. Close: Closes the Disc Info & Tools dialog when clicked. 
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Session Explorer 
If you want to retrieve files in the previous session from an Incremental or Independent Multisession 
CD, you cannot do it by using Windows Explorer, as Explorer only reads and displays the contents of 
the last session.  

The solution is Session Explorer, which provides the tool for retrieving files from any selected session 
on a CD to any selected drive.  

 

ª To retrieve files from a previous session: 

1. Insert the CD from which you want to retrieve files into the CD Recorder. 

2. Choose the Session Explorer… item from the Tools Menu. 

3. NTI CD-Maker will automatically detect and display the contents from the CD that 
is loaded in the default CD drive. 

4. Select the files you wish to retrieve from this CD. 

5. Click Copy To… to copy the selected files.  

6. A dialog box will be displayed allowing you to specify the location for the selected 
files that you want to retrieve. 

7. NTI CD-Maker will display a panel indicating the retrieval progress.  

Notes:   

³ When a complicated multisession CD is inserted, there may be a slight delay 
before CD-Maker is able to display the contents of the inserted CD. 

³ Choose Refresh from the Edit menu to refresh the display when you insert 
another CD. 
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Folder Compare Utility 
After completing CD recording, some users are anxious to delete the original files in the hard drive to 
increase its free space, without comparing the recorded data with original data, as they assume it should 
be all right.  

However, it is much safer to compare the recorded data with original data before acting on the original 
files. 

ª To compare files: 

1. Choose Compare Folders from the Tools menu. 

 
2. Select the two folders being compared and click OK. 

3. NTI CD-Maker will perform the comparison and list the details in a report. 

 



S U P P L E M E N T  T O  M A K I N G  A  C D - R O M  D I S C  

Supplement to Making A CD-ROM Disc 44 

Program Cache Buffer (Temporary Files) 
The Program Cache Buffer contains temporary files that are used to make read and write operations 
that occur during a recording session smooth and reliable. The main usage of the program cache buffer 
in making a CD-ROM disc are listed below: 

1. In the process of preparing the data to be written to the CD Recorder, CD-Maker 
will group certain small files (by default, any file of size less than small size file 
threshold 200 KB) in bigger temporary files. This is done simply to reduce the risk 
of buffer under-run errors, since otherwise it would take too much overhead to 
open, read, and close small files, potentially causing errors. 

2. If you are importing files from a network or removable disk, in the process of 
preparing data to be written to the CD Recorder, CD-Maker will copy all the files 
required from the network disk and/or removable disk. 

To configure the use of the program cache buffer, choose the Options… item from the Tools menu, 
and specify a path or tell CD-Maker to use same folder that is used by the operating system.  

You should specify a program cache buffer directory with enough space to hold future temporary files. 
If the program cache buffer has enough available space to hold all the temporary files created by CD-
Maker, the recorded data will be written on a single data track on the disc. Otherwise, CD-Maker will 
split the data into multiple tracks.  

In the “Network and Removable Disks Support” field, you can turn on or off the “Copy files to the 
Program Cache Buffer Directory, then write them to CD Recorder” option. When this option is turned 
on, source files residing on a network or removable media will be copied into the program cache buffer 
directory before writing to a disc. 
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Getting Started 
In this chapter, we will show you how to make Audio CD discs step-by-step. Before we start, let’s go 
over some key terms and concepts used in this chapter. 

Audio CD 
Audio CD is a basic compact disc format, also known as CD-DA (Compact Disc Digital Audio) which 
was the first CD standard. Audio CD uses PCM (Pulse Code Modulated audio), 44.1 kHz sampling, 16-
bit and stereo format.  

MPEG-1, Layer 3 (MP3) File 
MPEG-1 Layer 3, or MP3 as it is more commonly known, is the portion of the MPEG-1 specification 
dealing with the recording of audio information to a file. This standard has gained popularity on the 
Internet. Currently, most CD drives will not play this audio format directly.  NTI CD-Maker will 
translate MP3 files, on the fly, to wave files before they are written to the destination disc. 

Wave File 
A type of sound file that can store digitized analog signals supplied by the program. If the file’s format is 
not in the format of PCM, 44.1 kHz, 16-bit and stereo, you will have to use a Wave Editor to convert it. 

WMA File 
The Microsoft® Windows Media™ Audio format can handle all types of audio content, from speech-
only audio recorded with a sampling rate of 8 kilohertz (kHz) to 48 kHz high-quality stereo music. 
WMA format files require much less disk space for storage than WAV or MP3 files.  

Audio Track 
One song occupies one track, called an Audio Track on an Audio CD disc. You can record up to 99 
songs within one session on the disc.  

One Session Recommended 
You may have problems should you attempt to create/play multisession “Audio only” CDs. Most 
home and car stereos will only see the second and/or the last session of a multisession Audio CD.  
Many of these players are not able to read/understand the link to the previous sessions in the updated 
TOC.  Therefore, unless your Audio CD player can overcome this problem, we strongly recommend 
that you record only one session of audio data on an Audio CD disc. It is important to remember that 
multisession audio CDs are not within the Audio CD specification and may only play the last session or 
not work at all in many players. Attempting to copy a multisession Audio CD may produce 
unpredictable results. 

The Audio CD Recording Process 
During the process of preparing the data to be recorded to the disc, CD-Maker will copy the audio 
tracks, one at a time, from CD-ROM drive to a the program cache buffer on the hard disk. From there, 
the track is written to the CD Recorder. When you record Wave files to the disc, the files will be sent to 
the CD Recorder directly from the hard disk where the files are stored.  
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Step 1 — Creating a New Audio CD Layout 
The first step in making your Audio CD disc is to create or open an Audio CD layout and save it.  

Opening a new Audio CD layout 

ª To open a new Audio CD layout: 

1. Click the Audio icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Audio CD from the Audio Menu. 

Once you choose the Audio CD layout, CD-Maker will display the layout area with an Audio Track 
Layout in the destination pane. The source pane will contain the Explorer view as described in Chapter 
3. 

Saving the Audio CD Layout file 
Always remember to save your Audio CD layout once you have created it even though it is blank. You 
should save your layout file often enough to reduce the risk of losing your work.  

For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for Audio CD Virtual images. 

Building an Audio CD layout 
To build your Audio CD layout, you can import audio tracks from either your CD-ROM drive, MPEG-
1 Layer 3 (.mp3) files, WMA files or Wave (.wav) files from your hard disk. Importing files is easy with 
NTI CD-Maker. There are two basic ways to import files into your Audio CD layout.  

Notes: 
³ When an audio CD is used as a source and you are online, CD-Maker automatically looks for 

that CD in an online database. If a match is found, all album, track and artist information is 
updated from the online database. This information is kept and automatically inserted in the 
appropriate CD Text entries when you burn CD containing tracks from an audio CD. 

³ NTI CD-Maker automatically converts .mp3, .wma and .wav files to CD-DA tracks before 
they are written to the resulting Audio CD disc. 

³ Currently, WMA encoding is not available when running Windows 95, NT,  2000 or XP. 

Using the Add File Method 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Track Menu. When selected, CD-Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 
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Using the Explorer View (Drag-and-Drop) 
As discussed above, CD-Maker will display an Explorer view when creating or editing an Audio CD 
layout. From this view, you can select the files or folders you wish to import and drop them to the 
desired position in the audio track layout.  

ª To Add an audio track to the Audio CD layout: 

1. Navigate the resource tree to locate the desired audio track. 

2. Click on the desired file or folder. 

3. Hold the mouse button down while dragging the selection to the destination pane. 

4. Release the mouse button to drop the selected track in the destination layout. 

Note: 
³ CD-Maker’s explorer pane will display both the audio tracks and data 

files/folders found on a CD-Extra or Mixed-Mode disc is inserted in a CD 
drive on your system. 

Using the Gracenote CDDB service 
CD-Maker uses the Gracenote CDDB Music Recognition ServiceSM from Gracenote to display artist, 
and title information about the songs on an Audio CD.  CD-Maker will request this information from 
the Gracenote service when you click on a CD/DVD drive in the explorer view. In the case that the 
CD in the source drive has multiple entires or an exact match cannot be found, CD-Maker will present 
a list of possible matches. 

Notes: 
³ Title and Artist information will automatically be transferred to the Title and Performer CD Text  

fields as well as passed to JewelCase Maker for label and jewel case insert printing.  

³ Tracks from CDs that are not identified by the Gracenote Music Recognition Service will be 
listed as “Unknown” in the Title and Artist columns. 

³ This service is FREE.  The first time you use the service, you must register with Gracenote to 
use it. 

∇ Available in CD-Maker 6 Platinum only! 

Registering with the Gracenote CDDB service  
To register with the service, insert an audio CD into your drive and click on it in the explorer pane of 
any layout. The Gracenote CDDB Registration Wizard appears automatically.  Follow the screens for a 
“New Registration” to select a “nickname” and password.  The remaining information is optional, but 
does help Gracenote provide better service. 

Once you register, you do not have to re-register, unless you want to change your registration 
information or settings. 

For more complete instructions on using the Gracenote CDDB service you can visit their web site at 
http://www.cddb.com/cddb2info/using.html. 
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Using Audio Swapping 
In addition to using sound files like .mp3, .wav & .wma, you can create an Audio CD that includes 
tracks from one or more Audio CDs. Simply drag all your favorite tunes from your CD collection into 
the Audio layout and then burn your CD. CD-Maker will prompt you for all CDs necessary and save 
any CD-DA track to your temporary directory before burning the desired Audio CD. 

ª To burn an Audio CD using Audio Swapping: 

1. Create your Audio Layout as described above. 
2. Insert the audio CD you wish to copy tracks from into the CD/DVD ROM. 
3. Select the desired source CD drive from the resource tree. 
4. Drag and drop the tracks you want to copy to the Audio Track Layout. 
Notes: 

³ CD-Maker will ask you if you want to extract the file from the source CD 
now or wait until the Audio Layout has been completed. If you want CD-
Maker to copy the extract the audio track to your system now then choose 
the “Yes” option and click continue. Choosing the “No” option will 
extract all CD-DA tracks before burning the audio CD.  

³ You can click the browse button to select a new temporary directory if 
necessary. 

³ Check the Don’t Ask Again box to have CD-Maker remember your 
preference for future Audio Swapping operations. 

5. Repeat steps 4 and 5 to copy additional tracks from the current audio CD. 
6. Repeat steps 2 thru 5 to copy additional tracks from a different audio CD. 
7. Click Step 2 to burn your compilation CD.  
Notes: 

³ CD-Maker will now create temporary copies of any audio tracks in your 
layout from the CD that is currently in the source CD drive. Should any 
tracks in the current layout not be found on the CD currently in the 
source drive you will be prompted to enter the CD containing that track 
and press “Retry.” This will continue until all CD-DA tracks have been 
found and copied to the Program Cache Buffer directory. 

³ If you do not have enough free disk space to hold your temporary audio 
files an error message is displayed. You can either make more space 
available on your hard drive or switch temporary directory to a different 
hard drive by changing the “Directory for Program Cache Buffer” setting 
on the General Tab of the Options settings. The Options settings can be 
displayed by selecting the Options… item from the Tools Menu. 

8. If you are using the same drive as both the source and the target CD Maker 
will prompt you to “Please insert a recordable CDRW or CD-R disc into the 
CD-Recorder” after it has coping all necessary CD-DA tracks. Insert a blank 
disc and press “OK.” 

9. Click Yes at the “Do you still want to continue? ” prompt. 
10. Choose the writing options you want and click “Start” to burn your audio CD. 
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Using Play Lists (Drag-and-Drop) 

It is also possible to create an Audio CD layout from your favorite Music Café play lists. All .m3u 
compatible play list files may be dropped directly onto the CD Layout.  NTI CD-Maker will import all 
necessary track information from the play list.  

Note: 
³ The .m3u play list format is supported by other popular media players like WinAMP and 

MusicMatch. Check your media player to see if it supports the .m3u play list format. 

Editing an Audio CD Layout 
After you build your Audio CD layout, you can edit the layout to suit your preference. 

Deleting Audio Tracks 
You can delete selected audio tracks from your Audio CD layout.  

ª To delete an audio track from the Audio CD layout: 

1. Select the audio track to delete from the track list. 

2. Click Delete on the CD-Maker toolbar. 

3. Click Yes to confirm the deletion. 

Note: 
³ The delete function is also available from the Edit and Quick Command Menus. 

Moving Audio Tracks 
Audio tracks can be moved to any position in the track list of your Audio CD layout with a simple drag 
and drop. Select the audio track to be moved by clicking the left mouse button and then, while holding 
the left button, drag the file to a new position in the track list and drop it by releasing the left button. 
The selected file or folder will be moved and displayed in its new position. 

ª To move an audio track to a new position in the track list: 

1. Select the audio track to move. 

2. While holding down the left mouse button, drag the selection to the desired 
position in the track list. 

3. Drop it in the new location by releasing the left mouse button. 

Note: 
³ NTI CD-Maker displays a horizontal line across the track list to indicate where 

the track will be dropped in the track list.  

Alternatively, you can also change the Track Number field in the Audio Track Properties box, as 
described below.  



M A K I N G  A N  A U D I O  C D  

Making an Audio CD 52 

Playing an Audio Track 
You can play selected audio track from your Audio CD layout.  

ª To play an audio track from the Audio CD layout: 

1. Select the audio track to play from the track list. 
2. Choose the Play item from the Track Menu. 
Note: 
³ The play function is also available from the Quick Command Menu. 

Viewing Audio Track Properties 
You can view the properties for any audio track in your layout.  

ª To view the track properties of an audio track in the Audio CD layout: 

1. Select the desired audio track from the track list. 

2. Click Properties on the CD-Maker toolbar. 

3. Click OK to close the Track Properties dialog and make any requested changes. 

Note: 
³ The properties function is also available from the Track and Quick Command 

Menus. 

General Tab 
The General tab contains track title, number and description information for the selected audio track. 

 
• Track Title 

This is a text description of the track. Note that it will not be written to the disc - it is just 
for reference. You can give a new title to the selected track. For example, you can type in 
the corresponding song name in place of the default title “Track 6”. 

• Track Number 

You can update the Track Number in this field. This is an alternative method to move 
the track. 
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CD Text Tab 
The CD Text tab allows you to include additional information about the selected track including the 
Performer, Songwriter, Composer and Arranger.  

 
• Title 

Displays the track’s title information. 
• Performer 

Displays the track’s performer. 
• Songwriter 

Displays the track’s writer. 
• Composer 

Displays the track’s composer. 
• Arranger 

Displays the track’s arranger. 
Notes: 
³ These fields must be filled in to correctly record CD Text information on your Audio CD. Your 

CD recorder must support the writing of CD Text (See the Write Tab of the Drive Properties 
dialog to verify your drive’s capabilities.) You must also check the CD Text box of the Write CD 
dialog to enable the writing of CD Text information during the creation of an Audio CD. 

³ You can click the corresponding Apply to All Tracks button to copy the information entered to 
all tracks of this CD or Layout. 
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Filter Tab 
The Filter tab allows you to apply filtering to the selected wave file. This tab is not visible for other types 
of audio tracks. 

 
• Remove noise 

Check this box to filter out noise from the selected wave file. 

• Remove click and pop 

Check this box to filter out clicks and pops from the selected wave file. 

• Preview Button 

Click this button to play the selected wave file with the desired filtering. 

Notes: 
∇ Available in CD-Maker 6 Platinum only! 

³ This tab and the filtering feature are only available for wave files. 

³ Wave File Filtering is available on NTI CD-Maker Platinum. Please visit our website to upgrade 
your OEM version of CD-Maker to CD-Maker Platinum. 
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Setting the Audio CD Layout Properties 
The Audio CD Properties dialog allows you to set the following: Title, Performer, Songwriter, 
Composer and Arranger. 

 
ª To view/set the Audio CD layout properties: 

1. Click CD Layout Properties button on the toolbar. 

2. View/modify the CD Layout properties as desired. 

3. Click OK to close the Audio CD Properties dialog and make any requested 
changes. 

Note: 
³ The CD Layout Properties… item is also available from the Track and Quick 

Command Menus. 

Notes: 

³ Audio CD Properties (CD Text) are available for audio tracks recorded in the first session 
written in either Session-At-Once (SAO) or Disc-At-Once (DAO) writing modes.  

³ You can click the corresponding Apply to All Tracks button to copy the information 
entered to all tracks of this CD or Layout. 

Step 2 — Writing a Disc 
After you finish editing your Audio CD layout, you can start recording. It is a good idea to perform a 
test simulation to reduce the risk of errors. 

Test Writing a disc (Simulated Recording) 
A test simulation should be done regardless of the type of the image. Please refer to Chapter 3 for more 
details on how to perform this operation. 

Writing an Audio CD disc 
There is a difference between recording an Audio CD disc and recording a CD-ROM disc. For CD-
ROM disc recording, CD-Maker will try to write a single track to reduce the overhead of gaps in 
between tracks. However, in Audio CD disc recording, one track from the Audio CD image is one 
track on the disc. 
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After a successful simulation, you can write to the disc. The steps to write your Audio CD are the same 
as those for a test simulation. You must either select the Test & Write or Write option from the Write 
CD dialog box. Review the other settings and click Start to record your new CD. 

Note: 
³ Remember to set the Volume Balancing and CD Text options from the Write CD dialog. Please 

consult Write CD Options in Chapter 3 for specific information on these options. 

Audio File Conversions 
From time to time you may wish to convert a file in one audio format to another format altogether.  
CD-Maker supports conversions to and from the following Audio file formats: 

y CD-DA 

y Wave File (.wav) 

y MPEG-1, Layer 3 (.mp3) 

y Microsoft® Windows Media™ Audio (.wma) 

Converting a CD-DA Track to an Audio File 
You can convert a selected audio track from an Audio CD disc to any of the supported audio file 
formats. 

ª To convert a CD-DA track to an Audio file: 

1. Select the CD-DA track to be converted from the track list. 
2. Choose the Convert Audio File Format… item from the Track Menu or right click 

on the selected CD-DA track and choose Convert/Extract. 
3. Enter the new name and path information. By default, CD-Maker uses the same 

path as the source file. A .wav file extension will be automatically appended to the 
given file name. 

4. Select the desire file format option from the Save as type list. 
5. Click Save 
Notes: 
³ Unlimited MP3 encoding is available on NTI CD-Maker Platinum. All other 

versions offer MP3 encoding on a trial basis only! The trial lasts for twenty (20) 
conversions or thirty-days (30) days from the installation date. Please visit our 
website to upgrade your OEM version of CD-Maker to CD-Maker Platinum. 

³ If there is not enough space on the selected hard disk drive, a warning message 
box will be displayed. 

³ The Convert Audio Format… function is also available by right clicking on the 
desired track and selecting it from the Quick Command Menu. 

³ Currently, WMA support is not available when running Windows NT, 2000, XP 
or 95. 
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Audio File Format Conversions (Wave, WMA and MP3) 
You can convert any supported audio file format to another with NTI CD-Maker.  

ª To convert an audio file to another format: 

1. Select the audio file to be converted file from the track list. 

2. Choose the Convert Audio Format… item from the Track Menu, or right click on 
the selected audio file and choose Convert/Extract. 

 
3. Enter the new name and path information. By default, CD-Maker uses the same 

path as the source file. The appropriate file extension will be automatically appended 
to the given file name. 

4. Select the desired audio format option from the Save as type list. 

5. Click Save 

Notes: 
³ Unlimited MP3 encoding is available on NTI CD-Maker Platinum. All other 

versions offer MP3 encoding on a trial basis only! The trial lasts for twenty (20) 
conversions or thirty-days (30) days from the installation date. Please visit our 
website to upgrade your OEM version of CD-Maker to CD-Maker Platinum. 

³ If there is not enough space on the selected hard disk drive, a warning message 
box will be displayed. 

³ The Convert Audio Format… function is also available by right clicking on the 
desired track and selecting it from the Quick Command Menu. 

³ Currently, WMA support is not available when running Windows NT, 2000, XP 
or 95. 
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Summary 
An Audio CD disc is different from a CD-ROM disc. With a CD-ROM disc you are allowed to import 
multisession and re-edit the previous sessions at the file and directory structure level. However, with an 
Audio CD disc, you may have to discard the disc if you make any mistake on it. Therefore, as a 
precaution, before recording your Audio CD layout to a disc, you should always verify the image 
contents and layout to ensure the validity of the disc. 

We strongly recommend that you put all your audio tracks in one session on a disc to avoid problems 
when playing your audio disc on an Audio CD player. Remember you cannot turn off the CD recorder 
or eject the disc while CD-Maker is preparing to record the next track.  
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∇ Available in CD-Maker 6 Platinum only! 
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Getting Started 
In this chapter, we will show you how to make mp3 and wma CDs step-by-step. These CD types 
contain only audio tracks written in the selected format. For instance, a MP3 CD contains only audio 
tracks in the mp3 audio file format. In addition, the resulting CD will contain a play list in the .m3u 
format and an autorun.inf file to launch your music player when the MP3 CD is inserted in to the CD 
drive on your computer. 

Making a MP3 or WMA CD is easy. Simply select your favorite audio tracks from any source and in any 
supported audio format and add them to your layout. Next, organize your play list if you like. From 
there, click record button “Step 2” and CD-Maker goes to work. CD-Maker generates the playlist.m3u 
and the autorun.inf files and converts all the selected audio tracks into the mp3 audio format. From 
there, CD-Maker’s advanced recording engine burns the CD for you. You select the songs and CD-
Maker does the rest! 

Step 1 — Creating a New MP3 or WMA CD Layout 
The first step in making your MP3/WMA CD is to create or open a MP3 or WMA CD layout and save 
it.  

Opening a new MP3 or WMA CD layout 

ª To open a new MP3 or WMA CD layout: 

1. Click the Audio icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select MP3 CD or WMA CD from the Audio Menu. 

Once you choose the MP3 or WMA CD layout, CD-Maker will display the layout area with a Data 
Track Layout in the destination pane. The source pane will contain the Explorer view as described in 
Chapter 3. 

Saving the MP3 or WMA CD Layout file 
Always remember to save your MP3 or WMA CD layout once you have created it even though it is 
blank. You should save your layout file often enough to reduce the risk of losing your work.  

For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for MP3 or WMA CD Virtual images. 
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Building a MP3 or WMA CD layout 
To build your MP3 or WMA CD layout, you can import audio tracks from either your CD-ROM drive, 
MPEG-1 Layer 3 (.mp3) files, WMA files or Wave (.wav) files from your hard disk. Importing files is 
easy with NTI CD-Maker. There are two basic ways to import files into MP3 or WMA Audio CD 
layout.  

Notes: 
³ NTI CD-Maker automatically converts CD-DA, .mp3, .wma and .wav files before they are 

written to the resulting MP3 or WMA CD. 

³ Currently, WMA encoding is not available when running Window 95, NT, 2000 or XP. 

Using the Add File Method 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Track Menu. When selected, CD-Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 

Using the Explorer View (Drag-and-Drop) 
As discussed above, CD-Maker will display an Explorer view when creating or editing a MP3 or WMA 
CD layout. From this view, you can select the files or folders you wish to import and drop them to the 
desired position in the audio track layout.  

ª To Add an audio track to the MP3 or WMA CD layout: 

1. Navigate the resource tree to locate the desired audio track. 

2. Click on the desired file or folder. 

3. Hold the mouse button down while dragging the selection to the destination pane. 

4. Release the mouse button to drop the selected track in the destination layout. 

Note: 
³ CD-Maker’s explorer pane will display both the audio tracks and data 

files/folders found on a CD-Extra or Mixed-Mode disc is inserted in a CD 
drive on your system. 

Using Play Lists (Drag-and-Drop) 

It is also possible to create a MP3 or WMA CD layout from your favorite Music Café play lists. All .m3u 
compatible play list files may be dropped directly onto the MP3 or WMA CD Layout. NTI CD-Maker 
will import all necessary track information from the play list.  

Note: 
³ The .m3u play list format is supported by other popular media players like WinAMP and 

MusicMatch. Check your media player to see if it supports the .m3u play list format. 
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Creating a play list for a MP3 or WMA CD Layout  
After you build your MP3 or WMA CD layout, you can edit the play list that will be added to your CD 
to suit your preference. This play list will be used to determine the order that the audio tracks are played 
when your MP3/WMA CD is inserted into a CD drive on your computer. 

ª To play list for your MP3 or WMA CD layout: 

1. Click the Play list button on the MP3 or WMA CD layout. 

2. Drag and drop the mp3 tracks in the desired play sequence. 

Notes: 
³ The Audio Tracks are written to the CD in the order specified in the layout and 

will be played in that order when the CD is played from a MP3/WMA player. 

³ You can use the Shuffle button to randomly create the playing sequence or Reset 
to return to the original play sequence. 

Editing a MP3 or WMA CD Layout 
After you build your MP3 or WMA CD layout, you can edit the layout to suit your preference. 

Deleting Audio Tracks 
You can delete selected audio tracks from your MP3 or WMA CD layout.  

ª To delete an audio track from the MP3 or WMA CD layout: 

1. Select the audio track to delete from the track list. 

2. Click Delete on the CD-Maker toolbar. 

3. Click Yes to confirm the deletion. 

Note: 
³ The delete function is also available from the Edit and Quick Command Menus. 

Playing an Audio Track 
You can play selected audio track from your MP3 or WMA CD layout.  

ª To play an audio track from the MP3 or WMA CD layout: 

1. Select the audio track to play from the track list. 

2. Choose the Play item from the Track Menu. 

Note: 

³ The play function is also available from the Quick Command Menu. 
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Step 2 — Writing a Disc 
After you finish editing your MP3 or WMA CD layout, you can start recording. It is a good idea to 
perform a test simulation to reduce the risk of errors. 

Test Writing a disc (Simulated Recording) 
A test simulation should be done regardless of the type of the image. Please refer to Chapter 3 for more 
details on how to perform this operation. 

Writing a MP3 or WMA CD disc 
After a successful simulation, you can write to the disc. The steps to write your MP3 or WMA CD are 
the same as those for a test simulation. You must either select the Test & Write or Write option from 
the Write CD dialog box. Review the other settings and click Start to record your new CD. 

Summary 
A MP3 or WMA CD disc is essentially a CD-ROM disc that contains a play list, autorun and your 
selected audio files in the MP3 or WMA format.  
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Introduction 
In this chapter, we will discuss CD-Maker’s Video functions: Video CD and SuperVideo CD. Starting 
with this release, CD-Maker now supports the addition of a single-level menu to its existing VCD and 
SVCD functions. You simply create a menu screen using your favorite graphic editor and import it into 
your VCD/SVCD layout. 

Getting Started 
Before we start, let’s go over some concepts related to creating a VCD/SVCD disc. One of the ways to 
create a VCD/SVCD disc is by adding video clips in MPEG-1 or MPEG-2 format to the Video 
Layout. These MPEG files exist in a number of different formats. The video clips that you add to the 
Video CD/Super VCD layout must conform to the MPEG-1 for Video CD specification, as defined in 
White Book. Super VCD requires that the video clips conform to the MPEG-2 (ISO 13818-1, 1994) 
specification. See the file specifications below for details. In either case, CD-Maker verifies the source 
file and creates your VCD or SuperVCD disc at the click of a button. It is that easy! 

A VCD/SuperVCD disc must be recorded in a single session. You can use a VCD/SuperVCD or 
newer DVD player to play the VCD disc. 

MPEG 
MPEG-1 sources should conform to the Video CD specification as defined in “Video CD Specification 
Version 2.0” by Philips Consumer Electronics known as “White Book” and MPEG standard 
(ISO/IEC 111172) documents. MPEG-2 sources should conform to the MPEG standard (ISO 13818-
1, 1994). 

The MPEG-1 video data stream has three supported formats: NTSC, Film and PAL. The picture size 
and picture rate for each standard are listed here: 

Format  Picture Size Picture Rate 

NTSC  352 x 240  29.97 Hz 

Film  352 x 240  23.976 Hz 

PAL  352 x 288  25 Hz 

The MPEG-2 video data stream has two supported formats: NTSC and PAL. The picture size and 
picture rate for each standard are listed here: 

Format  Picture Size Picture Rate 

NTSC  480 x 480  29.97 Hz 

PAL  480 x 576  25 Hz 
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AVI Files 
Another way to make a VCD/SVCD is to add avi files to your video layout. An avi file may exist in 
many formats. It can be thought of as a wrapper of an audio source and video source into a single file 
and given an .avi extension. The format of the audio and video source can be one of many different 
types. They may be compressed or uncompressed. The key to all of this is the audio and video software 
installed on your computer. You must have the proper software on your system to “understand” the 
format of audio and video source before your system can play a given avi file. Those same translators 
(CODECs) are required for CD-Maker to be able to make a VCD/SVCD from a particular avi file. A 
general rule of thumb is that if Windows cannot play your avi file in the default media player then CD-
Maker will not be able to use that avi file either. 

A COmpressor/DECompressor, or CODEC is the piece of software that understands a particular 
audio or video source. They are generally added to your system through the installation of some other 
software component like Windows Media Player or DirectX. It may be possible to add additional 
CODECs to your system individually but doing so is beyond the scope of this manual. If you have an 
avi file that is not supported by the CODECs that are currently on your system you can look for the 
necessary CODECs from external sources like the Internet. It is always a good idea to make sure that 
you have the latest version of your media player and DirectX before continuing your search. 

When using a supported avi file, CD-Maker will automatically try to convert that file into its 
uncompressed audio and video components. These raw audio and video files will later be used to create 
the necessary MPEG-1 or MPEG-2 file necessary to create a VCD or SVCD disc. This decoding and 
then encoding process takes a lot of processor power and hard disk space. The amount of disk space 
depends on the size or the original avi file and the format and compression level of the audio and video 
streams contained within that avi file. As you might imagine, all this takes time. The amount of time can 
vary dramatically depending on your computer system. Some features like SlideShow without Audio or 
VCD/SVCD using an MPEG-1/2 file(s) as a source can go very quickly while building a SlideShow 
with Audio or VCD/SVCD from an avi file can take several hours to complete in the worst of cases. 

Image quality is also something to consider. Usually, the best quality and encoding speed result when 
the resolution and frame rate of the source AVI file match the output resolution of the destination 
MPEG file. If not, CD-Maker will convert the source image resolution to the target VCD/SVCD 
resolution. Always remember that there are many video-editing applications out there that may offer 
many different tools to improve the image quality of your MPEG files. You might find it necessary use 
one of these packages if you have an image quality problem with any video file.  

CD-Maker Version 6.0 includes a function to handle the creation of VCD discs from an avi file. The 
encoder is called directly from CD-Maker’s VCD layout any time that an avi file is included in the VCD 
layout item list. This encoder is also available in a stand-alone tool directly from the Tools Menu should 
you need to make an MPEG-1 file from any supported avi file. The resulting MPEG-1 file can be used 
to make a VCD simply by adding it to a VCD layout and burning a VCD from that layout. It is also 
available for your use in other video editing programs should you wish to do so. 

Note: 

³ As mentioned above, CD-Maker includes an AVI to MPEG-1 encoder for VCD functions. 
Optionally, CD-Maker offers an AVI to MPEG-2 encoder for SVCD functions. This 
encoder is available as a Plug-In from NTI’s website. Once installed, it operates like the 
MPEG-1 encoder but at the higher resolution of the MPEG-2/SVCD specifications. Once 
installed, this plug-in will also add MPEG-2 support to the stand-alone encoder tool. 
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Step 1 — Creating a Video CD/Super VCD Layout 
Opening a new Video CD/Super VCD layout 

ª To open a new Video CD/Super VCD Layout: 

1. Click the Video icon on the Home Screen. 
³ Note: 

If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Video CD or Super VCD from the Video Menu. 
Once you select Video CD from the New menu, the familiar Explorer view will be displayed in the 
source pane and a Video Track Layout will be displayed in the destination pane. The source pane will 
contain the Explorer view as described in Chapter 3. The Video Track Layout contains a menu pane on 
the left and a Video Item List on the right that displays Item, Type and Length for each video selection 
included in the current layout. 

Saving the Video CD/Super VCD Layout 
Always remember to save your virtual Video CD/Super VCD layout once you have created it. You 
should save your layout often enough to reduce the risk of losing your work.  
For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for Video CD/Super VCD layout files. 

Building a Video CD/Super VCD Layout 
To build your Video CD/Super VCD layout, you can import MPEG-1 (.mpg) or MPEG-2 (.mpg) files 
available from your system. Importing files is easy with NTI CD-Maker. There are two basic ways to 
import video clips into your layout.  
Additionally, you can add a menu to your VCD/SVCD layout and you must select either NTSC or 
PAL video output types from the layout pane.  
Notes: 

³ You can now drag and drop supported .avi files into your VCD layout. CD-Maker will test avi 
file and convert it to the MPEG-1 format prior to burning your VCD. Additionally, you can 
use CD-Maker’s MPEG-1 encoder tool to convert your AVI files to the MPEG-1 format. 
You must purchase the AVI to MPEG-2 plug-in from NTI to perform this conversion for 
SVCD discs. 

³ An AVI file can encapsulate many different formats of video files. Every AVI file indicates 
which video CODEC (COmpressor/DECompressor) is required to decode the encapsulated 
video file. You must have the required CODECs installed on your system to play or convert a 
particular AVI file. The general rule is that if you can play the AVI file on your Windows 
Media Player you can convert it using the CD-Maker MPEG-1/2 Encoder. If you cannot play 
a given AVI file you can try upgrading to the latest release of Windows Media Player from the 
Microsoft website. 

³ The AVI to MPEG conversion process can take a considerable amount of time and disk 
space due to the size of the files involved. The original AVI file is first decoded into its audio 
and video components and then multiplexed back into the resulting MPEG-1 file suitable for 
VCD/SVCD mastering. Please make sure you have 1 – 2 GB of free disk space on your 
Windows system drive. 
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Adding video clips to the Video Item List using the Add File Method 
You can manually select video clips to be imported into your layout by clicking the Add button on the 
toolbar or choosing the Add… item from the Track Menu. When selected, CD-Maker displays a 
standard Open dialog box allowing you to select the video clips to be imported to your video item list. 

Adding video clips to the Video Item List using the Explorer View (Drag-and-
Drop) 
As discussed above, CD-Maker will display an Explorer view when creating or editing a Video 
CD/Super VCD layout. From this view, you can select the video clips you wish to import and drop 
them on the video item list.  

ª To Add a video clip to the video item list: 

1. Navigate the resource tree to locate the desired video clip. 

2. Click on the desired video clip to select it. 

3. Hold the mouse button down while dragging the selection to the destination pane. 

4. Release the mouse button to drop the selected clip on the video item list. 

Adding a menu to a Video CD/Super VCD Layout 
CD-Maker supports a single-tier menuing system that uses a single graphic image in .bmp, .gif or .jpg 
format as a menu to be displayed on your VCD/SVCD disc. Adding a menu to your VCD/SVCD is 
simple. CD-Maker will display an Explorer view when creating or editing a Video CD/Super VCD 
layout. From this view, you can select the menu file you wish to use as the menu image and drop it on 
the menu area of the video layout.  

 

ª To Add a menu image to the VCD/SVCD layout: 

1. Navigate the resource tree to locate the desired menu image. 

2. Click on the desired menu to select it. 
3. Hold the mouse button down while dragging the selection to the destination pane. 
4. Release the mouse button to drop the selected clip on the menu area. 
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Editing the Menu Image 
After you build your Video CD/Super VCD layout, you can edit the menu image in your layout to suit 
your preference. CD-Maker will call the graphic editing program specified in the General Tab of the 
Options settings. Once you have edited your menu, save it and then replace the menu in your layout 
with the modified version you just saved. 

ª To edit a menu from the Video CD/Super VCD layout: 

1. Right click on the menu and select Edit. 

2. Edit the menu image in your favorite graphic editor and save the resulting image. 

3. Right click on the menu image and choose Replace Menu… 

4. Select the modified menu image file and click the Open button. 

Note: 
³ You can use the Image Editor item located on the General Tab of the CD-Maker 

Options settings to check the Use Default Editor box or specify the graphic 
editor program to use for all image-editing functions within CD-Maker. 

Deleting the Menu Image 
You can delete the menu image from your Video CD/Super VCD layout.  

ª To delete the menu image from the Video CD/Super VCD layout: 

1. Right Click the menu image and chose Delete. 

Editing the Video Item List 
After you build your Video CD/Super VCD layout, you can edit the video item list in your layout to 
suit your preference. 

Deleting a Video Clip 
You can delete selected video clips from your Video CD/Super VCD layout.  

ª To delete a video clip from the Video CD/Super VCD layout: 

1. Select the video clip to delete from the video item list. 

2. Click Delete on the CD-Maker toolbar. 

3. Click Yes to confirm the deletion. 

Note: 
³ The delete function is also available from the Edit and Quick Command Menus. 
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Changing the Play Sequence 
After adding video clips to the Video Track layout, you can design the layout to create the play 
sequence. Video clips can be moved to any position in the video item list with a simple drag and drop. 
Select the clip to be moved by clicking the left mouse button and then, while holding the left button, 
drag the file to a new position in the video item list and drop it by releasing the left button. The selected 
clip will be moved and displayed in its new position. 

ª To move a video clip to a new position in the video item list: 

1. Select the video clip to move. 

2. While holding down the left mouse button, drag the selection to the desired 
position in the video item list. 

3. Drop it in the new location by releasing the left mouse button. 

Note: 
³ NTI CD-Maker displays a horizontal line across the video item list to indicate 

where the clip will be dropped.  

Note: 
³ If you don’t specify the play order, then the item will be shown continuously when it is played 

back, until the user makes a selection using the remote control. 

Alternatively, you can also change the Item Number field in the Item Properties dialog, as described 
below.  

Previewing a Video Clip 
You can preview selected video clips from your Video CD/Super VCD layout.  

ª To preview a video clips from the Video CD/Super VCD layout: 

1. Select the video clip from the video item list. 

2. Choose the Play item from the Track Menu. 

Note: 
³ The play function is also available from the Quick Command Menu. 
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Using the AVI to MPEG Encoding Tool 
Now you can use CD-Maker’s new MPEG encoder tool to convert your AVI files into MPEG-1/2 to 
be used to create a VCD/SVCD disc. 

ª To convert an AVI file into a MPEG file: 

1. Select the Convert AVI to MPEG... item from the Tools Menu. 

 
2. Enter the name of the AVI file you wish to convert in the Input File area or use the 

browse button to locate the file to convert. 
3. Select the Output Stream Format. 
4. Enter the Output File Name. 
5. Click the Start button to begin the conversion process. 
Notes:   
³ You must purchase NTI’s MPEG-2 Encoder Plug-in from our web site to create 

an MPEG-2 file suitable for SVCD recording.  
³ Direct X Version 8.0 or above is required to decode AVI files containing a Divx 

data stream. This support is not available for the Windows NT operating system. 
³ Click the Play button in the Input File area to preview the selected AVI file. 
³ Click the Play button in the Output File area to view the resulting MPEG-1 file. 
³ Clicking on the viewing area will pause/continue the preview of the video files 
³ An AVI file can encapsulate many different formats of video files. Every AVI file 

indicates which video CODEC (COmpressor/DECompressor) is required to 
decode the encapsulated video file. You must have the required CODECs 
installed on your system to play or convert a particular AVI file. The general rule 
is that if you can play the AVI file on your Windows Media Player you can 
convert it using the CD-Maker MPEG-1 Encoder. If you cannot play a given 
AVI file you can try upgrading to the latest release of Windows Media Player 
from the Microsoft website. 

³ The AVI to MPEG conversion process can take a considerable amount of time 
and disk space due to the size of the files involved. The original AVI file is first 
decoded into its audio and video components and then multiplexed back into the 
resulting MPEG-1 file suitable for VCD mastering. Please make sure you have 1 
– 2 GB of free disk space on your Windows system drive. 
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Viewing Item Properties 
You can view the item properties for any video track in your layout. In the Item Properties dialog box, 
you will see the item title, number and description. The Item Properties dialog is displayed below: 

 
• Item Title 

This is a text description of the item. Note that it will not be written to the disc - it is just for 
reference.  

• Item Number 
You can update the Item Number in this field. This is an alternative method to move the 
video clip. 

• Source Format 
Displays various information about the format of the video item, including frame size, rate, 
number of frames in the item and play time for the item. 

ª To view the track properties of a video clip in the Video CD/Super VCD layout: 

1. Select the desired video clip from the video item list. 

2. Click Properties on the CD-Maker toolbar. You can view the properties or make 
any desired changes from this dialog. 

3. Click OK to close the Item Properties dialog and make any requested changes. 

Note: 
³ The properties function is also available from the Track and Quick Command 

Menus. 
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Step 2 — Writing a Disc 
After you finish editing your Video CD/Super VCD layout, you can start recording. It is a good idea to 
perform a test simulation to reduce the risk of errors. Before writing to the disc, be sure to define the 
Album, Volume and Date & Time information as defined below. 

Setting the Video CD/Super VCD Layout Properties 
The Video CD/Super VCD Properties dialog allows you to set the following:  

Album Tab 

 
• Album Identification 

This is a text identifier for this album. 

• Number of Volumes in Album 

Specify the number of CD volumes that make up this album. 

• Sequence Number of the Volume 

Specify the sequence number of this volume for this album. 

• Viewing Restrictions 

Specify the viewing restriction for this volume. 
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Volume Tab 

 

See “Setting the Volume Information on Page 23” for additional information about the 
volume settings. 

Date & Time Tab 

 

See “Date & Time on Page 24” for additional information about these settings. 

Test Writing a disc (Simulated Recording) 
A test simulation should be done regardless of the type of the image. Please refer to Chapter 3 for more 
details on how to perform this operation. 

Writing to the disc 
After a successful simulation, you can write to the disc. You must either select the Test & Write or 
Write option from the Write dialog box. Review the other settings and click Start to record your new 
CD.
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Introduction 
In this chapter we will discuss CD-Maker’s Video functions: VCD and SVCD Slideshow CDs with and 
without Audio. New to this release is the SlideShow function. CD-Maker will allow you to create a list 
of image files (bmp, gif and jpg files are currently supported) and specify the time to display each image. 
Optionally, add your favorite music (CD-DA, mp3, wma and wav formats are currently supported) and 
tell CD-Maker to burn your slideshow disc in VCD or SVCD format. It is that simple. You select the 
images and tunes and CD-Maker creates your SlideShow CD that can be shared with your family and 
friends on their home computer or on many of the newer DVD players on the market today. 

Note: 

³ Not all DVD players can play VCD or SVCD discs. Please check the specifications of your 
player to be sure that your DVD player will play VCD or SVCD on CD-R or CD-RW media. 

Getting Started 
Before we start, let’s go over some concepts related to creating a slideshow disc. SlideShow discs can be 
created in either the VCD or SVCD format. There is a separate layout for each format type. The 
operation of the layout is the same for VCD and SVCD with the only difference being the type of CD 
being created by the layout. Please remember that the AVI To MPEG-2 Encoder Plug-In is required to 
create a SlideShow disc in the SVCD format. 

The SlideShow CD 
The SlideShow CD layout allows you to specify a list of images that can be displayed from your 
VCD/SVCD player. Optionally, you can include a play list of audio tracks to be played as the images are 
displayed. Images in the Slide Track List are synchronized to the audio play list when background music 
is included in the slideshow layout. Because of this synchronization, the layouts operate slightly 
differently when audio files are added to the SlideShow layout. 

SlideShow CD Without Background Audio 
The creation of a SlideShow CD is a three-step process with Step Two, adding background audio, being 
optional. As mentioned above, the manner that CD-Maker handles the display of the images in the Slide 
Track List depends on whether or not you have included one or more audio tracks in Step Two. When 
you click Step Three to burn your SlideShow CD and no audio tracks have been added to the 
Background Audio list in Step Two, CD-Maker will create a VCD/SVCD disc where the images can be 
displayed for a specified time. This time period can be a specific amount of time or indefinitely. Images 
that are not given a specific time require that you use the Next button on your VCD/SVCD/DVD 
player to display the next image. All other images are displayed for the amount of time specified and 
then the next image will be displayed. The images are displayed in the order they appear in the Slide 
Track List. The playing time can be set from the Slide Properties dialog. Simply select the slide in the 
Slide Track List and click the Properties button on the toolbar to display the Slide Properties dialog.  

Using Background Audio 
Step Two of the SlideShow CD layout supports the addition and synchronization of the images being 
displayed with background music on the CD. To add background audio to your SlideShow CD, simply 
add your favorite audio files to the Background Audio list. You can add a single audio track that lasts the 
length of all the slides included in the Slide Track List, you can repeat a single audio track as necessary to 
display all slide images or you can add multiple audio files that will be used to synchronize the display of 
all slide images contained in the Slide Track List. 
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Considerations With The Use of Background Audio 
There are a few things to consider when using Background Audio on your SlideShow CDs. First, the 
use of background audio is optional. Because of the need to synchronize the video and audio, CD-
Maker must create an MPEG file that contains the video frames of the slides synchronized with the 
audio play list. The resulting MPEG file is used to create the SlideShow CD. This type of slideshow is a 
movie that is generated from the information contained in your SlideShow layout. Once played, the 
movie gives the effect that the slides are synchronized with the background audio. One difference here 
is that the Next button on your VCD/SVCD/DVD player does not advance you to the next slide. 
However, you can use the Fast Forward/Backward buttons to move to a different place in the 
slideshow. All controls will operate as if you are playing a movie since that is what your SlideShow CD is 
when you have added Audio to the SlideShow layout in Step Two. 

It is important to understand that building an MPEG file from the SlideShow layout is a demanding 
process on any computer. The audio and slide files and settings must be compared and then adjusted to 
perform the synchronization required. The audio files from the play list are combined to create a single 
audio stream that is later used to create the MPEG file. The same is true for the slide images. Each 
image must be replicated many times to perform the requested synchronization. It takes some thirty 
frames to display a slide for a single second. If your slideshow is designed to last for even ten minutes 
then you need some 18,000 video frames to create that ten-minute video file. Throw in the screen 
resolution for a VCD or SVCD and the color setting and size of the raw video file needed to create the 
ten minute MPEG file quickly exceeds 10 GB (NTSC MPEG-2 for SVCD SlideShow). As you can see, 
you will need to have considerable free space on your hard drive for the temporary work files during 
this process. It can also be a lengthy process to generate a SlideShow CD with background audio 
included. Limiting the output to VCD and using lower color resolution settings in your slide images will 
minimize these requirements. This should be considered on older systems with older processors, limited 
memory and insufficient free space on your hard drive. 

Understanding Audio/Video Synchronization 
Before you can design your SlideShow CD, you must understand how CD-Maker synchronizes the 
slide images in your Slide Track List with the track(s) specified in the Background Audio list. Once you 
have added your audio and slide images in your SlideShow layout, set the display time for your slide 
images and clicked Step Three then CD-Maker goes to work. CD-Maker calculates the total display time 
for all images in the Slide Track List and the total play times of all tracks in the background audio list.  

In addition, CD-Maker must take care of the special condition when the Next option is selected as the 
display time for any slide image. For SlideShow CDs with background audio the Next option tells CD-
Maker to display this slide image until the current audio track stop playing. In other words, display this 
slide until the start of the next audio track in the background audio list. It is easy to create a SlideShow 
CD that displays each slide for an entire audio track using the Next option. Simple add one audio track 
for every slide in the Slide Track List and set all display times to Next.  

The Three Roads to Synchronization 
As you can see, CD-Maker is quite busy when you start to burn your SlideShow CD. Along with 
keeping track of all play times for all audio tracks and the display times for each slide image, CD-Maker 
must determine the overall length of the video. The total length of a SlideShow CD depends on the 
selections you make in your layout. CD-Maker checks the play times for all audio tracks, the state of the 
Repeat option and the display times of each slide image to perform the overall synchronization process. 
First, CD-Maker builds an audio stream from all tracks in the Background Audio list. Next, CD-Maker 
calculates the total time to display each slide from the Slide Track List. At this point, there are three 
possibilities. 
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Option 1 – Audio and Video Streams Match 
One, the playtime for the composite audio files exactly matches the total display times for all slide 
images. In this case, everything is fine and CD-Maker can continue to build the SlideShow CD. The 
simplest example was mentioned above. Add one audio track for each Slide in your layout and use the 
Next option for the display time setting for each slide image. 
Example 1: 

Audio Track Play Time Calculated Slide Image Display Time Calculated
Song A 4:01 4:01 Slide 1 Next 4:01
Song B 0:23 0:23 Slide 2 Next 0:23
Song C 1:18 1:18 Slide 3 Next 1:18

Audio Totals: 5:42 5:42 Video Totals: N/A 5:42
Repeat: Disabled(Not Checked)  
Note: 

³ The Repeat option has no effect in this example. 

Option 2 – Audio Stream Exceeds the Video Stream 
The second possibility is that the composite audio stream exceeds the total display time of all slide 
images. In this case, CD-Maker displays the final slide image until the end of the audio stream. In 
essence, CD-Maker forces the display time of the last slide image to act like Next was selected for that 
slide.  
Example 2: 

Audio Track Play Time Calculated Slide Image Display Time Calculated
Song A 4:01 4:01 Slide 1 1:00 1:00

Slide 2 1:00 1:00
Slide 3 1:00 2:01

Audio Totals: 4:01 4:01 Video Totals: 3:00 4:01
Repeat: Disabled(Not Checked)  
Notes: 

³ The Repeat option has no effect in this example. 
³ Slide 3’s display time is extended to 2:01 to synchronize the audio and video streams for 

this layout. 

Option 3 – Video Stream Exceeds the Audio Stream 
The third possibility is the most complex. In cases where the total video time exceeds the total play time 
for the composite audio stream, CD-Maker must then check the repeat option on the Background 
Audio list. If the repeat option is not enabled then there is no way to complete the synchronization 
process and a message is displayed telling you to either select the repeat option, add additional audio 
tracks to the Background Audio list or adjust the number of slides or the display times of the slides in 
your current Slide Track List. It is up to you to make the necessary corrections and try to burn your 
SlideShow CD again. 
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If the repeat option was enabled then CD-Maker will extend the length of the composite audio stream 
until it matches or exceeds the calculated display times of all slides in your layout. CD-Maker does this 
by appending as many tracks as necessary starting from the top of the Background Audio list to the 
existing composite audio stream. Once the audio stream exceeds the slide display times, CD-Maker can 
synchronize the video stream by adjusting the display time of the final slide to make the video and audio 
streams equal in play/display times. 
Example 3: 

Audio Track Play Time Calculated Slide Image Display Time Calculated
Song A 4:01 4:01 Slide 1 Next 4:01
Song A 4:01 Slide 2 Next 4:01
Song A 4:01 Slide 3 1:18 4:01

Audio Totals: 4:01 12:03 Video Totals: N/A 12:03
Repeat: Enabled(Checked)  
Notes: 

³ The Repeat option forces the composite audio stream to be extended to 12:03 by adding 
two copies of Song A. 

³ Slide 3’s display time is extended to 4:01 to complete the synchronization of the audio and 
video streams for this example. 

Once the audio and video lists have been synchronized and the composite audio stream has been built, 
CD-Maker can build the synchronized video stream, frame at a time, using the slide images contained in 
the Slide Track List. From here, it is possible to build the necessary MPEG file and burn the resulting 
SlideShow CD. 

Note: 

³ As mentioned above, CD-Maker includes an AVI to MPEG-1 encoder for VCD functions. 
Optionally, CD-Maker offers an AVI to MPEG-2 encoder for SVCD functions. This encoder is 
available as a Plug-In from NTI’s website. Once installed, it operates like the MPEG-1 encoder 
but at the higher resolution of the MPEG-2/SVCD specifications. Once installed, this plug-in 
will also add MPEG-2 support to the stand-alone encoder tool. 

Opening a new SlideShow layout 

ª To open a new VCD or SVCD SlideShow Layout: 

1. Click the Video icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select VCD SlideShow or SVCD SlideShow from the Video Menu. 

Once you select the slideshow option, the familiar Explorer view will be displayed in the source pane 
and a Slide Track Layout will be displayed in the destination pane. The source pane will contain the 
Explorer view as described in Chapter 3. The Slide Track Layout contains an image pane on the left and 
a Slide Track List on the right that displays Slide, Type, Length and Source for each slide selection 
included in the current layout. 
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Saving the SlideShow Layout 
Always remember to save your virtual SlideShow layout once you have created it. You should save your 
layout often enough to reduce the risk of losing your work.  
For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for SlideShow layout files. 

Setting the Playing Time for a Slide Image 
As mentioned earlier in this chapter you must set your display time for each slide in your layout. By 
default, CD-Maker selects the “Next” option for a slide when it is first added to the Slide Item List. 
Also, remember that this option operates differently when you add background music to your 
slideshow. For slideshows without background music, selecting “Next” means that you must manually 
advance to the next slide using the controls of your VCD/SVCD/DVD player. For slideshows that 
feature background music, selected “Next” means that this slide will play until the start of the next audio 
track in your background track list. Entering a time value will display the selected slide for the time 
specified before displaying the next frame. 
Note: 
³ See the instructions in the next section to view and edit the Slide Properties. 

Viewing the Slide Properties 
You can view the item properties for any video track in your layout. In the Slide Properties dialog box, 
you will see the Slide title, number and description. The Slide Properties dialog is displayed below: 

 
• From 

This is the file name and location information for the selected slide image. 
• Slide Number 

You can update the Slide Number in this field. This is an alternative method to reposition the 
slide in the Slide Track List using the mouse. 

• Playing Time 
For slideshows without background music, selecting “Next” means that you must manually 
advance to the next slide using the controls of your VCD/SVCD/DVD player. For 
slideshows that feature background music, selecting “Next” means that this slide will play until 
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the start of the next audio track in your background track list. Entering a time value will 
display the selected slide for the time specified before displaying the next frame. 

• Apply to All Slides 
Check this box to apply the Playing Time selection to all slides in your layout. 

• Set as Default Playing Time 
Check this box to make this Playing Time selection the CD-Maker default. 

• Source Format 
Displays various information about the format of the slide image, including video format and 
frame size for the selected slide. 

ª To view/edit the slide properties of an image file: 

1. Select the desired slide image from the slide track list. 

2. Click Properties on the CD-Maker toolbar. You can view the properties or make 
any desired changes from this dialog. 

3. Click OK to close the Slide Properties dialog and make any requested changes. 

Notes: 
³ All Playing Time values must be entered in seconds. 

³ The properties function is also available from the Track and Quick Command 
Menus. 

Step 1 — Prepare the Slide Track List 
In Step 1, you must create the list of slides to be included on your SlideShow by importing .bmp, .jpg 
and .gif slide image files available from your system. Importing files is easy with NTI CD-Maker. Once 
you have all the slides included in your Slide Track List you must set the Playing Time from the Slide 
Properties dialog for each slide on your list. Other editing functions are similar as those found on the 
VCD/SVCD layouts. Please consult Chapter 7, “Making a Video CD/Super VCD Disc.” for additional 
information on the preparation of the Slide Track List. Once you have created and saved your Slide 
Track List then click the Step 2 button to move to the background audio portion of the SlideShow CD 
layout. 

Step2 — Prepare the Background Audio List 
To prepare the background audio portion (Audio CD part), you need to switch to the Background 
Audio List view of the SlideShow CD Layout. Please refer to Chapter 5 for specific instructions on 
working with audio track layouts. 

Step 3 — Write the SlideShow disc 
Once you have created and saved your audio track layout then the final step is to write your virtual 
image to disc. Simply click the Step 3 button to write your SlideShow CD. 
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 Step 3 — Write the Mixed-Mode disc 
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 Step 1 — Prepare the Audio Track 
 Step 2 — Prepare the Data Track 
 Step 3 — Write the CD Extra disc 
 
Summary 
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Making a Mixed-Mode CD Disc  

Mixed-Mode refers to the combination of CD-ROM and Audio CD formats on the same disc. A 
Mixed-Mode disc contains one track of CD-ROM data followed by one or more Audio CD tracks.  

Opening a new Mixed-Mode CD layout 

ª To open a new Mixed-Mode CD layout: 

1. Click the Advanced icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Mixed-Mode from the Advanced Menu. 

Once you open a virtual Mixed-Mode CD image, CD-Maker will display a data track layout in the 
destination pane. The source pane will contain the Explorer view as described in Chapter 3. 

When creating Mixed-Mode CD, CD-Maker will record a single session CD with first track of ISO 
9660 in CD-ROM or CD-ROM XA format from a virtual Data CD layout followed by audio tracks.  
NTI CD-Maker will record the data track from an existing Data CD layout or one that you will create. 

Saving the Mixed-Mode CD layout 
Always remember to save your virtual Mixed-Mode CD layout once you have created it. It is a good 
idea to save a new layout even though it is blank. You should save the layout file often enough to reduce 
the risk of losing your work.  

For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for all layout files. 

Step 1 — Prepare the Data Track 
Step 1 prepares the data portion (Data CD part) of the Mixed-Mode CD layout.  NTI CD-Maker 
selects it automatically when you open the new Mixed-Mode CD layout as described above. Please 
follow the steps described in Chapters 3 and 4, “Making a CD-ROM Disc”. Once you have created and 
saved your data track layout then click the Step 2 button to move to the audio portion of the 
Mixed-Mode CD layout. 

Step2 — Prepare the Audio Track 
To prepare the audio portion (Audio CD part), you need to switch to the Audio Track Layout view of 
the CD Image. Please refer to Chapter 5 for specific instructions on working with audio track layouts. 

Step 3 — Write the Mixed-Mode disc 
Once you have created and saved your audio track layout then the final step is to write your virtual 
image to disc. Simply click the Step 3 button to write your Mixed-Mode disc. 
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Making a CD Extra Disc 

A Mixed-Mode CD contains data in the first track followed by one or more audio tracks, in a single 
session. A normal audio CD player attempts to play all tracks in succession. This results in a very loud 
noise and possible damage when playing a Mixed-Mode CD in a normal CD player. CD Extra, also 
known as CD Plus or Enhanced CD, is the solution to the above problem. It contains two sessions. 
The first session contains up to 98 audio tracks and the second session contains a data track written in 
the CD-ROM XA format. 

Playing a CD Extra disc in a normal Audio CD player plays the audio tracks in the first session, and 
never reads beyond the first session, so the data track is never played and the loud noise and possible 
damage are avoided. A CD-ROM drive that is able to read a multisession CD, however, reads the last 
session on the CD, so it finds the data track. The application can then be used to play back the sound. 

Opening a new CD Extra layout 

ª To open a new CD Extra layout: 

1. Click the Advanced icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select CD Extra from the Advanced Menu. 

Once you open a CD Extra layout, CD-Maker will display an audio track layout in the destination pane. 
The source pane will contain the Explorer view as described in Chapter 3. 

When creating a CD Extra disc, CD-Maker will record two sessions on the resulting CD. The first 
session will contain the audio tracks from your layout. The second session contains a data track using 
the ISO 9660 naming restrictions written in the CD-ROM XA format.  NTI CD-Maker will record the 
data track from an existing virtual Data CD image or one that you will create. 

Saving the CD Extra layout 
Always remember to save your virtual CD Extra layout once you have created it. It is a good idea to 
save a new layout even though it is blank. You should save the layout file often enough to reduce the 
risk of losing your work.  

For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for all layout files. 

Step 1 — Prepare the Audio Track 
Step 1 prepares the audio portion (Audio CD part) of the CD Extra layout.  NTI CD-Maker selects it 
automatically when you open the new CD Extra layout as described above. Please refer to Chapter 5 for 
specific instructions on working with audio track layouts. Once you have created and saved your audio 
track layout then click the Step 2 button to move to the data portion of the CD Extra layout. 
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Step2 — Prepare the Data Track 
To prepare the data portion (Data CD part) of your CD Extra disc, please follow the steps described in 
Chapters 3 and 4, “Making a CD-ROM Disc”.  

Step 3 — Write the CD Extra disc 
Once you have created and saved your data track layout then the final step is to write your virtual image 
to disc. Simply click the Step 3 button to write your CD Extra disc. 

Summary 
One Session Recommended 
It is recommended recording only one session on a Mixed-Mode disc.  

Program Cache Buffer (Temporary Files)  
NTI CD-Maker uses the program cache buffer when creating both CD-ROM discs and Audio CD 
discs. The cache buffer is required for creating a Mixed-Mode disc. The free disk space requirement for 
the program cache buffer used in creating a Mixed-Mode CD is the larger size of the program cache 
buffer used in creating a CD-ROM disc and a Audio CD disc, respectively. 

During simulated recording or real recording, CD-Maker will check to see if there is enough free disk 
space in the program cache buffer directory to meet the size requirement. If there is not enough free 
disk space, you must allocate more disk space before writing to CD. 

Playing Mixed-Mode Discs 
A CD-ROM drive is smarter than a regular CD player. When you play a Mixed-Mode disc on the CD-
ROM drive, the data tracks will be ignored. When you play the Mixed-Mode disc in your audio CD 
player, however, you may damage your CD player since it will play the data tracks as if they were audio 
tracks. Please do not try this.  
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Getting Started  

Custom CD refers to the ability to create a CD from one or more ISO or RAW format image files. 
Each file is written as a complete track on the final CD. You can place these files in any order in your 
Custom CD layout. You can use your favorite software package or CD-Maker’s Data CD function or 
the Read Track operation on the Disc & Info Tools dialog to create a disc image file (.iso or .raw only).  

Step 1 — Creating a New Custom CD Layout 
The first step in making your Custom CD disc is to create or open a Custom CD layout and save it.  

Opening a new Custom CD layout 

ª To open a new Custom CD layout: 

1. Click the Advanced icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Custom CD from the Advanced Menu. 

Once you choose the Custom CD layout, CD-Maker will display the layout area with a Custom Track 
Layout in the destination pane. The source pane will contain the Explorer view as described in Chapter 
3. 

Saving a Custom CD Layout 
Always remember to save your Custom CD layout once you have created it even though it is blank. 
You should save your layout file often enough to reduce the risk of losing your work.  

For details on how to perform the Save function, please refer to similar steps in Chapter 3. By default, 
CD-Maker will use the .CDM extension name for Custom CD Virtual images. 

Building a Custom CD layout 
To build your Custom CD layout, you can import tracks from CD-Maker or any application capable of 
generating disc image files. Importing files is easy with NTI CD-Maker. There are two basic ways to 
import files into your Custom CD layout.  

Using the Add File Method 
You can manually select files to be imported by clicking the Add button on the toolbar or choosing the 
Add… item from the Track Menu. When selected, CD-Maker displays a standard Open dialog box 
allowing you to select the files to be imported. 
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Using the Explorer View (Drag-and-Drop) 
As discussed above, CD-Maker will display an Explorer view when creating or editing a Custom CD 
layout. From this view, you can select the files or folders you wish to import and drop them to the 
desired position in the audio track layout.  

ª To Add an image file to the Custom CD layout: 

1. Navigate the resource tree to locate the desired image file. 

2. Click on the desired file. 

3. Hold the mouse button down while dragging the selection to the destination pane. 

4. Release the mouse button to drop the selected track in the destination layout. 

Editing a Custom CD layout 
After you build your Custom CD layout, you can edit the layout to suit your needs. 

Deleting Image Files 
You can delete selected audio tracks from your Audio CD layout.  

ª To delete an image file from the Custom CD layout: 

1. Select the image file to delete from the track list. 

2. Click Delete on the CD-Maker toolbar. 

3. Click Yes to confirm the deletion. 

Note: 
³ The delete function is also available from the Edit and Quick Command 

Menus. 

Moving Image Files 
Image files can be moved to any position in the track list of your Custom CD layout with a simple drag 
and drop. Select the image file to be moved by clicking the left mouse button and then, while holding 
the left button, drag the file to a new position in the track list and drop it by releasing the left button. 
The selected file will be moved and displayed in its new position. 

ª To move an image file to a new position in the track list: 

1. Select the image file to move. 

2. While holding down the left mouse button, drag the selection to the desired 
position in the track list. 

3. Drop it in the new location by releasing the left mouse button. 

Note: 
³ NTI CD-Maker displays a horizontal line across the track list to indicate where 

the image file will be dropped in the track list.  

Alternatively, you can also change the Track Number field in the Track Properties dialog, as described 
below.  
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Viewing the Image File Properties 
You can view the properties for any image file in your layout.  
General Tab 
The General tab contains track name, number and source information for the selected image file. It also 
contains the track mode, block size and length information in the Track Format section of the dialog 
box. 

 
• Track Name 

This is a text description of the item. Note that it will not be written to the disc - it is just 
for reference.  

• Track Number 
You can update the Track Number in this field. This is an alternative method to move 
the image file. 

• From 
Displays the source location of the image file. 

• Track Format 
Displays various information about the format of the image file, including mode, block 
size, and length of the image file. 

ª To view the track properties of an image file in the Custom CD layout: 

1. Select the desired image file from the track list. 
2. Click Properties on the CD-Maker toolbar. 
3. Click OK to close the Track Properties dialog and make any requested changes. 
Note: 

³ The properties function is also available from the Track and Quick Command 
Menus. 
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Setting the Custom CD Layout Properties 
The Custom CD Properties dialog allows you to choose the disc type for the Custom CD you are 
creating. Select from CD-DA, CD-ROM, CD-ROM XA, CD-I and DVD-ROM formats. 

 

Step 2 — Writing a Disc 
After you finish editing your Custom CD layout, you can start recording. It is a good idea to perform a 
test simulation to reduce the risk of errors. 

Test Writing a disc (Simulated Recording) 
A test simulation should be done regardless of the type of the image. Please refer to Chapter 3 for more 
details on how to perform this operation. 

Writing a Custom CD disc 
After a successful simulation, you can write to the disc. The steps to write your Custom CD are the 
same as those for a test simulation. You must either select the Test & Write or Write option from the 
Write CD dialog box. Review the other settings and click Start to record your new CD. 

Summary 
CD-Maker’s Custom CD feature relaxes many of the rules used when creating any of the other CD 
types. You can use the .iso and .raw image files created directly from CD-Maker or the image file output 
from other programs capable of creating CD image files. Remember, each image file in the Custom 
Track Layout is written as a new track of the Custom CD. The full power of CD-Maker is now in your 
hands.
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∇ Available in CD-Maker 6 Platinum only!
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Chapter 11 — Topics of discussion 
 

Getting Started 
 Step 1 — Creating a Live Audio CD image 

Opening a new Live Audio image 
 

 Step 2 — Write a Live Audio disc 
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Getting Started  

Live Audio refers to recording live audio input from a microphone or other audio source to an audio 
track on a CD-R disc. It might be that you wish to record some piece of music from your collection.  
You can do this with NTI CD-Maker and live audio recording.  NTI CD-Maker will record live input 
from either a microphone or other devices connected to your sound card. You can connect a 
microphone to the microphone port of the sound card or any other device that can connect to the Line 
In port of your sound card.  NTI CD-Maker will collect the live audio information passed to it by the 
sound card and write it to an audio track on the disc. 

Note: 
³ Live audio recording requires that your drive support 1X writing to CD-R media. 

Step 1 — Creating a Live Audio CD Layout 

Opening a new Live Audio layout 

ª To open a new Live Audio CD layout : 

1. Click the Audio icon on the Home Screen. 

³ Note: 
If you are in a different layout then you can click the Home button on the 
toolbar to return to the Home Screen. 

2. Select Live Audio from the Audio Menu. 

Once you open a Live Audio CD layout, CD-Maker will display an audio track layout in the destination 
pane. You simply select the input source from the Audio combo box. There is no actual layout file 
required as the audio information is retrieved from your sound card and written directly to the CD-R 
media. All the recording is done during Step Two as discussed below. 

Adjusting the volume for Live Audio CD recording. 

ª To adjust the volume for Live Audio CD recording: 

1. Double-click the Volume Control icon on the system tray next to the time. 
2. Select the Properties item from the Options Menu. 
3. Select the "Recording" option. 
4. Place a check mark next to the Line-In or Microphone box(depending on your 

audio source) and Press OK. 
5. Place a check mark in the "Select" box to choose either Microphone or Line-

in(depending on your audio source). 
6. Minimize, but do not close Volume Control dialog box. 
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Step 2 — Write a Live Audio CD disc 

 
Simply click the Step 2 button from the layout area to write your Live Audio CD disc.  NTI CD-Maker 
displays a Record Live Audio dialog when you click the Step 2 button.  
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Clicking the Start button causes CD-Maker to record the live audio data coming from your system’s 
sound card and start recording it to disc. Simply click Stop to end the recording process.  

 
Once all the audio data is written to the CD-R disc, a “Recording Finished” message appears in the 
Record Live Audio dialog and the Close and Start buttons are again enabled. You can record additional 
Live Audio samples or click Close to end your live audio recording. You will be asked if you wish to 
close the session once you have exited the Record Live Audio dialog. You should leave the session open 
if you have more data to record on this disc. It is a good idea to leave your session open until you have 
recorded all the desired audio  selections. 

Note: 
³ Select the “NTI Disc Image Writer” as the recorder to save the Live Audio recording to a 

wave file for later use. 
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Copying a CD or DVD Disc 
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Chapter 12 — Topics of discussion 
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 Selecting the Copy function 
 
Step 1 — Select Source and Target Drives 

Copying Source to Hard Disk Before Copy 
 
Step 2 — Copy the Disc 
 
Creating an NTI CD Image File (.ncd) from an Existing CD 
 
Creating a CD from an Existing NTI CD Image File (.ncd) 
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Getting Started 
Copying a CD/DVD has never been easier than using CD-Maker.  NTI CD-Maker’s Copy feature 
enables you to make a copy from a CD disc to a CD-R disc (in a CD-Recorder) when both drives are 
connected to the PC. This functionality is similar to that of the DOS “diskcopy” command for floppy 
diskettes except for CD discs. When you have both a CD reader and a CD writer, no hard disk space is 
required to duplicate the source CD, copying the CD can be done on the fly! 

Selecting the Copy function 
The Copy function is accessed just as you were going to create any other type of CD/DVD using CD-
Maker. The difference is that you are not creating an image layout so you cannot save or open functions 
are not necessary. All you do is select the Copy function, choose the source and target drives then copy 
the disc. It’s that simple! 

ª To select the Copy function: 

1. Click the Copy icon on the Home Screen. 

Note: 
³ If you are in a different layout then you can click the Home button on the toolbar 

to return to the Home Screen. 

Step 1 — Select Source and Target Drives 
Selecting the Source and Target Drives 
After opening the Copy window, CD-Maker checks your system for the presence of CD-ROM devices. 
If you have both a CD Reader and a CD Recorder, it will automatically select the reader as the source 
drive and the recorder as the target. It will list all CD/DVD drives in the CD-Drive combo box and all 
CD-Recorders in the CD Recorder combo box. You may select any CD device as the source and any 
CD Recorder as the target. Once these devices are selected, CD-Maker verifies the media in each device. 
The amount of information on each disc is displayed. 

Copying Source to Hard Disk Before Copy 
You can tell CD-Maker to copy the information on the source CD to your PC’s hard drive before 
attempting to create a copy on the target drive. This can be helpful in eliminating problems caused by a 
slower CD reader. The source device must be able to provide its data fast enough to keep up with the 
recording device’s ability to write to the disc. Please remember that you must have enough space 
available on your hard drive to hold all of the information on the source device. It can be up to 780 MB 
in some cases! 

ª To copy the source data to the hard disk before a copy operation: 

1. Check the Copy to Hard Disk box on the CopyCD layout. 

Note: 
³ This option is safer than on-the-fly recording but takes a longer time and 

requires that more hard disk space be available on your machine. 
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Step 2 — Copy the Disc 
Once you have selected the source and target drives from step one, the final step is to copy the disc. 
Simply click the Step 2 button to start the copy process. 

Note: 

0 Attempting to copy non-standard CDs (i.e. multisession Audio CDs) may produce unpredictable 
results. 

Creating an NTI Disc Image File (.ncd) from an Existing CD/DVD 
You can use Copy to create an NTI Disc Image file (.ncd) of your favorite CDs and save it on your 
hard drive. Simply select the Source drive as usual and choose Disc Image Writer from the Target drive 
list. All you have left to do is click Step 2 to create the image.  

Alternatively, you will be asked if you want to save the temporary image file created when using the 
copy source to hard disk option. 

Creating a CD/DVD from an Existing NTI Disc Image File (.ncd) 
It is also possible to burn one or more CDs/DVDs from an existing NTI Disc Image file (.ncd) using 
Copy . Simply select the Disc Image Reader from the Source drive list and choose the target drive as 
usual. All you have left to do is click Step 2 to create the CD/DVD. 

Compare Discs 
You can use CD-Maker’s Compare Discs function to verify the new CD against the original. The 
Compare Discs item can be found on the Tools Menu.  

ª To compare CDs: 

1. Choose Compare Discs from the Tools menu. 

Notes: 
³ CD-Maker will display the Compare Discs dialog box and begin the compare 

operation. Should any difference be found the compare operation is halted and 
a message is displayed indicating the two discs are not the same. 

³ Audio tracks will fail to compare in most instances. For this reason, the 
Compare Discs function will skip all audio tracks during the compare 
operation. Only the data track of a Mixed-Mode or CD Extra disc will be 
compared when using this function. 
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More About Compact Discs 
Physical Structure on a CD 
 
As defined by the Orange Book format standards, a CD's physical structure is: sectors are enclosed 
within tracks, tracks are enclosed within sessions, and sessions are enclosed within the disc.  

Measurement of Information Stored on a CD 
Since CD-ROM originated from audio CD, the amount of information stored on disc can be measured 
in terms of minutes, seconds, and frames, where   

1. 1 minute = 60 seconds 
2. 1 second = 75 frames 
3. 1 frame = 2048 bytes (2 Kilobytes) of Mode 1 user data 

Note: 
³ Due to the overhead of sector boundaries, the actual space occupied by a file on the disc is 

usually larger than its original size. 

CD Formats 
CD format standards include the following: 

1. The Red Book: Defines CD-Audio format standards. 

2. The Yellow Book: Defines CD-ROM, CD-ROM XA format standards. 

3. The Green Book: Define CD-I format standards. 

4. The Orange Book: Defines CD-Recordable parts I & II format standards. 

5. The White Book: Defines Video CD format standards. 

Write-Protected Disc 
When your CD Recorder receives the Finalize Disc command, it will write the Lead-In (with TOC) and 
Lead-Out to the disc. This indicates to the CD Recorder that no more sessions may be added after this 
last one. 
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Image Files 
NTI CD-Maker can create the following types of image files: 

1. ISO Image File (.iso) – ISO image files contain the data portion of a CD track. The block size 
is 2048 bytes.  

2. RAW Image File (.raw) – RAW image files contain all data associated to a CD track. This 
includes the data, header, and error correction information for that track. The block size is 
2352 bytes. 

3. NTI Disc Image File (.ncd) – NTI format image file that contains an image of a CD/DVD. 
They can be created using Copy or any of the mastering modes. See Copy for instructions on 
burning a CD/DVD from an NTI Disc Image file. 

Note: 
³ Other image file types can be used when creating a Custom CD but are not created by CD-

Maker. Consult the application that you used to create the image file for Mode and Block Size 
information for that file type. You can use the Track Properties dialog to set the Mode and 
Block size for any image file in your Custom CD layout. 

Creating an ISO/RAW Image File from a Data CD Layout 
You can output a Data CD layout to an ISO or RAW image file directly from CD-Maker. 

ª To create an ISO/RAW image file from a Data CD layout: 

1. Open or create the Data CD layout (See Chapter 3). 

2. Choose the Create ISO CD Image File… item from the File Menu. 

 
3. Enter the new name and path information. By default, CD-Maker uses the same path as 

the source file. 

4. Select the type of image file from the Save as type list. 

5. Click Save 
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Creating an ISO/RAW Image File from an existing CD/DVD 
You can create an image file from an existing disc. 

ª To create an ISO/RAW image file from an existing CD/DVD: 

1. Select the Disc & Info Tools… from the Tools menu. 

 
2. Select the track you wish to import to an image file and Click the Read Track… 

button. 

 
3. Enter the new name and path information. By default, CD-Maker uses the same 

path as the source file. 

4. Select the type of image file from the Save as type list. 

5. Click Save. 
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Creating a CD from an ISO/RAW Image File 
You can burn a CD from a previously saved ISO or RAW image file directly from CD-Maker. 

ª To create a CD from an ISO/RAW image file: 

1. Open a new Data CD layout (See Chapter 3). 

2. Choose the Create CD from ISO CD Image File… item from the File Menu. 

 
3. Select the type of image file from the Save as type list. 

4. Click Open. 

5. Choose the write options and click Start. 

Creating an NTI Disc Image File (.ncd) from an Existing CD/DVD 
As mentioned above, ISO and RAW file images can only be created while using the Data CD function. 
However, you can create an NTI Disc Image file (.ncd) from any layout or previously saved layout file.  
Simply build the layout as usual and choose Disc Image Writer from the Target drive list. All you have 
left to do is click Step 2 to create the image.  

Writing Methods  
There are four writing methods in the Write CD dialog box. They are Smart decision, Track-At-Once, 
Session-At-Once and Disc-At-Once. 

Smart decision 
NTI CD-Maker automatically selects the writing method based on the type of CD you are going to 
write. This is the default selection and the best choice in most cases. 

Track-At-Once 
With Track-At-Once writing method, the CD Recorder will record one track at a time. In between 
tracks, the CD Recorder laser will stop while the hard disk prepares the contents of the next track. 
There are two run-out blocks written when a CD Recorder finishes writing a track and there is one link 
block and four run-in blocks when a CD Recorder starts to write the next track. When you read a CD-
ROM, CD-Audio or Mixed-Mode disc in either a CD-ROM drive or CD Recorder, these blocks will 
not have any adverse effect since both drives are smart enough to skip all these blocks and will not play 
them.  
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However, since some audio players do not support Track-At-Once, when you play CD Audio disc 
created with this method in such audio players, you may hear some funny noises in between song 
tracks. Therefore, to make a master CD in any format that is to be mastered and replicated in the 
factory, you must use the Disc-At-Once writing method. To make a professional CD-Audio disc, it is 
strongly recommended that you use Disc-At-Once. 

Session-At-Once 
Session refers to data written to a CD during the span of a single recording. Sessions are identified by a 
lead-in area and a lead-out area that indicates the close of a session. Multi-session refers to a form of 
recording that allows data to be written over more than one session. The disc can be removed from the 
recorder in between sessions and then replaced. 

Session-At-Once is related to the process of recording multisession discs. With Session-At-Once writing 
method, CD-Maker writes all the data at the span of one recording operation. In between sessions, the 
CD Recorder laser will stop while the hard disk prepares the contents of the next session.  

Disc-At-Once 
With Disc-At-Once writing method, the CD Recorder laser will not stop until the whole disc recording 
is finished. In this writing method, the disc will be closed and there are no link blocks between any two 
tracks. As explained above, Disc-At-Once is recommended for making master CD’s. 

Considerations in Recording to the Disc 
In the process of recording to a disc, if any interruption occurs, you will fail to write the disc and your 
disc may be ruined. There are a few things to consider before writing to a disc to ensure the writing 
process will be as reliable and trouble-free as possible. 

The Data 
If the source files linked with your CD image layout consist of many small files, CD-Maker will store 
those files with a size less than 200 KB (by default) to the program cache buffer. You can adjust this 
default threshold file size to ensure smooth transfer of data to the CD Recorder. As long as your 
program cache buffer has been allocated enough free disk space, you should increase the threshold to 
allow as many small files as possible to be stored to the program cache buffer.  

ª To adjust the small file threshold: 

1. Choose the Options item from the Tools menu. 

2. Click the Advanced tab. 

3. Adjust the Cache small size files slider to the desired setting. 

Note: 
³ Larger threshold sizes will allow more small files to be copied to the program 

cache buffer. Moving the slider to the right increases the small file threshold 
value. Moving it all the way to the right will cause all files to be cached to disk 
prior to being written to the target media. 
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Speed of Hard Disk 
You should store your source data on a sufficiently fast local hard disk, which can provide a fast data 
transfer rate. 

SCSI Card 
The SCSI card data transfer rate should also be considered. The faster the SCSI card, the better your 
performance. 

CD Recorder Buffer Size 
The larger the CD Recorder’s buffer size, the safer and more reliable your recording sessions will be. On 
some recorders, you can upgrade the buffer size. For information on upgrading buffer size on your 
CD Recorder, please refer to documents provided by the CD Recorder manufacturer. 

Thermal Recalibration 
Thermal recalibration is a process by which some hard drives pause to recalibrate themselves in 
response to internal drive temperature changes. On some intelligent hard disks, during recording, 
thermal recalibration can be postponed. However, on other hard disks, thermal recalibration is 
performed at fixed intervals—even when your hard disk is in use, like when you are recording a disc. If 
an interruption in the data flow caused by hard disk thermal recalibration occurs during your recording, 
the recording may not be successful. A fast host system goes a long way towards solving this problem. 
Many modern drives perform intelligent thermal recalibration so this is becoming less of a problem in 
CD recording. 

Fragmentation 
If your source files are stored on a fragmented hard disk, searching for these source files will slow down 
the recording operation, and may cause buffer underrun. To reduce such problems, run a disk 
defragmentation utility to defragment your hard disk before recording. 

Recording Speed 
You should perform the simulation step each time after you have set a different recording speed. If the 
simulation test fails, you should choose a lower speed and test again. 

CD Recorder & SCSI Hard Disk 
If your hard disk is a SCSI hard disk, we recommend that you connect your CD Recorder and SCSI 
hard disk to two different host adapters. This will separate the source and the destination of your 
recording, making it safer. 

Buffer Underrun Error Protection Technologies 
Many current recorders support some type of buffer underrun error protection technology.  There are 
several new technologies available today. Sanyo’s Burn Proof and Ricoh’s JustLink were the first 
implementations available but others, like SeamlessLink, ExacLink and SuperLink are available on the 
market today. These protection technologies are built directly into the drive and they prevent buffer 
under-run errors from producing the infamous "coaster". This condition is caused when the writing 
buffer is empty when the recording process is still under way. When this condition occurs, the recording 
process is aborted as incomplete and the media is ejected. Once this happens, the CD-R media cannot 
be used again, relinquishing itself to the "coaster" bin. Avoiding this situation can be a very trying 
experience with no guarantees, and the conditions of cause will change from occurrence to occurrence. 
With the buffer under-run error protection facility activated, the normal abort sequence is circumvented 
by the drive. Later, when the write buffer accumulates enough data to be written, the drive synchronizes 
and "retraces" where the under-run occurred and continues to write from that point.  
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NTI CD-Maker fully supports these technologies, virtually eliminating the coaster effect on drives with 
one of these technologies built in. If your CD Recorder/ReWriter supports either technology, you can 
enable it from the Buffer Underrun Error Protection tab of the Options dialog box. You can check the 
Write tab of the Drive Properties dialog, available from the Tools menu, for your drive to see if it 
supports one of the many buffer under-run error protection technologies. 

Drive Properties 
The Drive Properties dialog displays the read and write capabilities of the selected drive. You can also 
set the Audio Extraction Speed for a drive using this dialog. The Drive Properties can be displayed by 
clicking on the Drive Properties… item on the Tools Menu or clicking the property sheet button to the 
right of the drive selection control. The Drive list will contain all CD/DVD drives attached to your 
system. 

 
General Tab: 
The general tab provides product and vendor information about the selected drive. 

Vendor ID – Displays the vendor of the selected drive. 
Product ID – Displays the Product ID String of the selected drive. 
Firmware Version – Displays the firmware version of the selected drive. 
Cache Memory – Displays the amount of cache memory installed on the selected drive. 
Drive Letter – Displays the drive letter of the selected drive. 
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Write Tab: 
The write tab indicates the write speeds and supported features of the selected drive. 

CD-R Speed – This drive writes to CD-R media at these speeds. 
CD-RW Speed – This drive writes to CD-RW media at these speeds. 
DVD Speed – This drive writes to DVD media at these speeds. 
CD Text – This drive will write the CD-Text information to the media. 
Buffer Underrun Error Protection – This drive supports one of the current buffer underrun error 
protection technologies (i.e. Burn Proof, JustLink, SeamlessLink, ExacLink or SuperLink). 
Overburn – This drive supports Overburning™. 
Disc-At-Once – This drive supports the Disc-At-Once writing method. 
Session-At-Once – This drive supports the Session-At-Once writing method. 
Packet Writing – This drive supports packet writing. 
Write UPC & ISRC – This drive supports the writing of UPC and ISRC code information to the 
media. 

Read Tab: 
The read tab indicates the supported maximum read speed and supported features of the selected drive. 

Max Speed – This drive will read at this speed. 
Audio Extraction – This drive supports audio extraction. 
Audio Accurate – This drive will accurately extract audio information. 
Read CD-RW (Multi-read) – This drive supports multi-read for CD-RW media. 
Method 2 (Multi-read) – This drive supports multi-read for the CD-ROM XA format. 
Read UPC & ISRC – This drive supports the reading of UPC and ISRC code information from 
the media. 

Audio Extraction Tab: 
The Audio Extraction tab displays/sets the audio extraction speed for the selected drive. 

Default – Use the factory default extraction speed for this drive. 
Best Quality – Use the speed that extracts audio data the most accurately. 
Fastest Speed – Use the fastest speed supported by this drive for audio extraction regardless of 
quality. 

Advanced Tab: 
The Advanced tab displays/sets special advanced features for the selected drive. 

Enable Just Speed – Just Speed is a function that prevents writing errors when writing at high 
speeds (16X and above). When enabled, the drive decides the best writing speed based on the 
results of the drive’s own medium calibration. 
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Audio Extraction Speed 
The audio extraction speed control allows you to select the extraction speed to use on a given drive. In 
general, you want to select the fastest speed that delivers accurate audio extraction. Use the Drive 
Properties dialog to set the extraction speed for the source drive. You can choose from the factory 
default, best quality or the fastest extraction speed supported by the selected drive. Selecting “Best 
Quality” performs a test of the extraction capabilities of the selected drive and displays the results.  NTI 
CD-Maker will choose the fastest speed that provides accurate extraction. 

ª To set the Audio Extraction Control for a drive: 

1. Select the Drive Properties… item from the Tools Menu. 

2. Select the desired drive from the list. 

3. Select the desired setting for the Audio Extraction Speed Control. 

4. Click OK to save the new extraction speed setting. 

Note:   
³ If you choose the Best Quality option, you will be prompted to insert an Audio 

CD in the selected drive so that CD-Maker can test the extraction capabilities of 
the selected drive. The results of the extraction testing will be displayed once the 
test has completed. 

Speed Measurement 
Beginning with Version 4.2, CD-Maker can automatically test the speed of the data source and then 
limit the writing speed to prevent the burning of a bad CD “coaster” due to the lack of input data. The 
speed measurement feature will prevent using the fastest write speed of your CD Recorder in some 
circumstances but you will achieve much better burning results.  

The speed measurement functions samples the availability of all source data required to produce the CD 
being created. Once the testing has completed, the write speed is set to an appropriate level for the data 
source. You may adjust the size of the sample data or disable the speed management should you so 
desire. These settings are available on the Preference Tab of the Options dialog from the Tools Menu. 
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Error Messages 
The Log File 

NTI CD-Maker will create a log file that allows you to trace and diagnose problems that can occur 
during recording.  NTI CD-Maker will report all errors that have occurred in recording to this log file. 
By default, this file, logfile.txt, is located in the installation directory for your NTI CD-Maker software. 

NTI CD-Maker will overwrite the log file every time you perform a recording so it will always contain 
the results of your last write/test operation. You will be given the option to view the log file when an 
error occurs. You should have this information available should you contact our technical support team 
by phone or include it with any correspondence you may have regarding a problem you are having with 
NTI CD-Maker. 

You can specify the location and name for the log file. Choose the Options… item from the Tools 
menu and select the General tab. You must check the “Report to log file” box and enter a file name and 
path for the log file to be created by CD-Maker. 

The log file contains the following information: 
1. CD-Maker Product and version. 
2. Time and date of the recording session. 
3. Disc Format (Type of disc you were creating). 
4. Number of Tracks to be recorded. 
5. Total Blocks to be recorded. 
6. CD-Recorder and firmware version. 
7. Media Type 
8. Test Mode 
9. Writing Speed 
10. Writing Method 
11. Was the disc to be finalized (Closed)? 
12. Was the session to be closed? 
13. NTI Error Code. 
14. Failing Command and Status information. 

Error Messages 
Please consult our Troubleshooting Guide at support.broderbund.com for a complete listing of all 
NTI CD-Maker error messages and other helpful troubleshooting hints and tips! 

Note:   
³ A copy of the Troubleshooting Guide may be also installed with NTI CD-Maker.  Check the 

program folder for availability.
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Chapter 14 — Topics of discussion 
 
NTI CD-Maker Commands 

Menu Bars 
File Menu 
Edit Menu 
Track Menu 
View Menu 
Step Menu 
Help Menu 
Quick Command Menus 

 
Toolbar 
 
CD Info Bar 
 
Status Bar 
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NTI CD-Maker Commands 
All CD-Maker menus can be invoked by a single left-button click of a mouse on the menu title. Menu 
items are aligned on the left, with keystroke shortcuts (if applicable) displayed on the corresponding 
right side. The underlined character of a menu item, if pressed (through the keyboard), will have the 
same effect as if the menu item were selected with the mouse. 

Menu Bars 
CD-Maker’s menu bar changes depending on the type of track you are working on. It displays an Edit 
Menu when you are working with data track layouts and a Track Menu for Audio or Video tracks. 

D A T A  T R A C K  M E N U  B A R  

 
A U D I O / V I D E O / C U S T O M  T R A C K  M E N U  B A R  
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File Menu 

 
New 
Creates a new image layout of the selected type. 

Open… 
Opens an existing virtual layout file. 

Close 
Closes the current virtual layout file and displays the Welcome screen. 

Save  
Saves the current virtual layout file (.cdm) on your computer. 

Save As… 
Saves the current virtual layout file to a disk file on your computer. 

Disc Layout Properties 
Displays the properties of the current virtual layout. 

Write Disc 
Writes the current image to the target drive. 

Create ISO Disc Image File… 
Creates an ISO image file of the current Data Layout. 

Create Disc from ISO Disc Image File… 
Creates a CD/DVD from a saved ISO Disc Image file. 

Recent Files  
Displays the most recently used layout files. 

Exit  
Exits the CD-Maker program. 
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Edit Menu 

 
New Folder 
Creates a new folder in the current data track layout. 

Cut 
Removes the selected object from the data track layout but leaves a copy of the object in the 
clipboard for later paste operations. 

Copy 
Copies the selected object from the data track layout to the clipboard for later use. 

Paste  
Pastes the contents of the clipboard into the data track layout. 

Add… 
Adds files/folders to the data track layout.  

Delete  
Deletes the selected object from the data track layout. No copy is left on the clipboard. 

Rename  
Renames the selected object in the data track layout.  

Select All  
Selects all items in the destination pane. 

Invert Selection  
Inverts the current selection. 

Properties  
Displays the properties of the currently selected file or folder. 
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Track Menu 

 
Add… 
Add a new audio track to the current Audio CD image. 

Delete 
Deletes the selected audio track from the Audio CD image. No copy is left on the clipboard. 

Play 
Plays the currently selected audio track. 

Filter 
Set up filtering for the currently selected audio track. 

Edit Wave 
Opens the Wave Editor with the selected file ready for editing. 

Convert Audio Format… 
Converts audio track formats. 

Properties 
Displays the properties of the currently selected audio track. 

View Menu 

 
Small Icons 
Toggles between the Small Icon and Detail display mode in Explorer pane. 

Refresh 
Refresh the current view. 
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Tools Menu 

 
Options… 
Displays NTI CD-Maker program options dialog. 

Find… 
Launches the Windows Find All Files function. 

Compare Folders… 
Compares any two folders and reports the results. 

Compare Discs… 
Compares two Discs. It is only available from the Copy view. 

Erase Rewritable Disc… 
Allows you to perform a quick or full erase of your rewritable disc. 

Disc Info & Tools… 
Launches CD-Maker’s Disc Info & Tools utility. 

Drive Properties… 
Displays various information about a drive. 

Session Explorer 
Launches Session Explorer for use with multi-session discs. 

View Log File 
Displays NTI CD-Maker log file. 

JewelCase Maker 
Launches the JewelCase Maker program. 

Wave Editor… 
Launches the Wave Editor program. 

Convert AVI to MPEG… 
Launches the AVI to MPEG Encoder tool. 

Live Update… 
Updates the CD-Maker Supported Drive Database (You must be online to use this feature). 
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Help Menu 

 
Help Contents 
Displays the CD-Maker online help system. 

Register My Software 
Links you to our online registration page. 

NTI Home Page 
Links you to our home page @ www.ntius.com. 

CD-Maker Home Page 
Links you to the CD-Maker home page @ www.nticdmaker.com. 

Frequently Asked Questions on the web 
Links you to our FAQ page @ www.ntius.com/faq.htm. 

Software Update Download Page 
Links you to our software download page @ www.ntius.com/download/index.cfm. 

Technical Support Page 
Links you to our technical support page @ www.ntius.com/support/index.htm. 

About NTI CD-Maker… 
Displays version and program information about NTI CD-Maker. 

About Gracenote CDDB… 
Displays the Gracenote CDDB About dialog. 
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Quick Command Menus 
Like the main menu bar, CD-Maker’s Quick Command menu changes depending on the type of track 
you are working on. It displays an edit-style menu while working with data track layouts and a track-style 
menu for audio or video tracks. 
Edit-style quick command menu for data track layouts 

 
New Folder 
Creates a new folder in the current data track layout. 
Cut 
Removes the selected object from the data track layout but leaves a copy of the object in the 
clipboard for later paste operations. 
Copy 
Copies the selected object from the data track layout to the clipboard for later use. 
Paste  
Pastes the contents of the clipboard into the data track layout. 
Add… 
Adds files or folders to the data track layout.  
Delete  
Deletes the selected object from the data track layout. No copy is left on the clipboard. 
Rename  
Renames the selected object in the data track layout.  
Select All  
Selects all items in the destination pane. 
Invert Selection  
Inverts the current selection. 
Properties  
Displays the properties of the currently selected file or folder. 
Disc Layout Properties… 
Displays the properties of the current layout. 
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Track-style quick command menu for audio and video track layouts 

 
Add… 
Add a new audio track to the current Audio CD image. 

Delete 
Deletes the selected audio track from the Audio CD image. No copy is left on the clipboard. 

Play 
Plays the currently selected audio track. 

Filter 
Set up filtering for the currently selected audio track. 

Edit Wave 
Opens the Wave Editor with the selected file ready for editing. 

Convert Audio Format… 
Converts audio track formats. 

Track Properties 
Displays the properties of the currently selected audio track. 

Disc Layout Properties… 
Displays the properties of the current layout. 
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Toolbar 
This section describes the Main Toolbar in NTI CD-Maker. 

M A I N  T O O L B A R    

   

Toolbar buttons are used as shorthand for menu commands. Each toolbar button represents a 
frequently used command. The display of these buttons is context-sensitive in that only buttons relevant 
to the current context are shown and enabled. 

The following is a run-down of the Main Toolbar buttons and their respective menu commands. 

Button Icon Button Name Menu Command 

 New File Menu:   New 

 Open File Menu:   Open... 

 Save File Menu:   Save 

 Home None. 

 Record File Menu:   Write Disc 

 Up One Level None. 

 Find Files Tools Menu:   Find… 

 Add Edit/Track Menu:   Add… 

 Delete Edit/Track Menu:   Delete 

 Properties Edit/Track Menu:   Properties 

 Erase Tools Menu:   Erase Rewritable Disc… 

 Disc Info & Tools Tools Menu:   Disc Info & Tools… 

 Disc Layout Properties File Menu:   Disc Layout Properties… 

 About Help Menu:   About NTI CD-Maker 
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CD Info Bar 
The CD Info Bar displays the amount of space used by the current CD layout. It displays usage in 
minutes for Audio and Video CD layouts and in MegaBytes (MB) for Data CD layouts. It provides a 
quick visual queue showing you the amount of space used as you add files to the current CD layout.  

The usage bar is colored to indicate the amount of data in the current layout as follows: 

Grey – Amount of space used from previous sessions (Data CD/DVD Layouts Only!). 
Green – New data added from the current layout. 
Yellow – Data to be written in the overburn space for this layout. 
Red – Data that would be overwritten into the Lead-Out Area for this CD. This is an 

error condition and the CD created from this layout may not be readable or may 
hang when it is read. 

The CD InfoBar may contain up to three indicator lines. The green indicator line shows the end of the 
normal data area. The yellow line indicates the value contained in the Maximum CD Size setting. This 
setting defines the point the CD-Maker will not burn beyond while using the Overburn capability of 
your drive. A red line indicates the end of the Lead-Out Area on this CD. 

Notes: 
³ You can set the Maximun CD Size as well as enable the Overburn feature from the Overburn 

Tab of the CD-Maker Options dialog.  

³ Overburn is not supported on all drives. 

³ The yellow line and data area are not visible if the Overburn feature is not enabled. This could 
happen because your drive does not support overburn or that it is not enabled. In this case, 
no writing will be allowed past the end of the normal data area as indicated by the green line 
on the CD InfoBar. 

Warnings and Limitations!  
CD-Maker will warn you of several possible problems with your layout. These warnings depend on the 
type of media used to create a CD from your layout as well as the burner itself. Since these safeguards 
require information about the piece of media being used, they are only valid once you insert a piece of 
media into your drive. At that point, CD-Maker checks your layout against the type of media you are 
using and will warn/limit you accordingly. In an effort to be somewhat proactive (i.e. try to prevent lost 
time due to problems in your layout at the time a bad change is made), CD-Maker uses a default media 
size when no media is in your burner. CD-Maker will generate warnings using this default media size 
(currently 74 minutes/650 MB) unless media is inserted into the target drive and the CD InfoBar is 
updated accordingly. 
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Warnings: 
1. “Not enough free space” – Anytime your data exceeds the normal data area and Overburn is 

disabled/not supported (the drive may not support overburn or your layout may not be using 
DAO).  

2. “Not enough free space” – Anytime your data exceeds the normal data area,  Overburn is 
enabled and you have exceeded the Maximum CD Size.  

3. “Your layout has exceeded the amount of data normally contained on this type of media. Do 
you want to use your drive’s overburn feature to record this layout?”  
– Anytime your data exceeds the normal data area,  Overburn is enabled and you have not 
exceeded the maximum CD Size.  

A) Answering “No” displays the “Not enough free space” message. 

B) Answering “Yes” burns the CD assuming that there are no other issues with this 
layout. 

Limitation: 
1. Anytime that the “Not enough free space.” message is displayed, you must correct the 

condition by changing the layout as necessary. CD-Maker will not burn the CD/DVD unless 
there is enough free space on the piece of media currently inserted into the target drive. 

Inserting a piece of media in the Target Drive. 
The bar is rescaled to reflect the parameters for the type of media being inserted. If there is any data in 
the current layout then it must be displayed and validated against the new parameters. If the current 
layout as defined is too large to fit on the piece of media being inserted then the user should be notified 
“This layout will not fit on the disc you just inserted. You will need to insert a different disc or modify 
your layout to fit on this CD.” 
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Glossary 
a-character 

A characters are capital A to Z, digits 0 to 9, and also the following symbols: ! “ % & ‘ ( ) * + , - . / : ; < 
= > ? _ 

ASPI 

ASPI stands for Advanced SCSI Programming Interface. This defines a set of software commands for 
applications to use when communicating with SCSI host adapters. 

Back Cover (U-Card) 

Back cover inserts are printed on one side and the edges are folded back for insertion into the back 
cover of the jewel case. 

Block 

A group of 2352 bytes as defined by the Yellow Book standard.  

Compact disc 

CD stands for Compact Disc, which is a general term for all formats of CD media. CD formats 
available on the market now include Audio CD, CD-ROM, CD-ROM XA, Video CD, Enhanced CD 
or CD Extra and CD-I. 

Audio CD 

Audio CD, which is a standard CD format for storing audio sound tracks, for example, music and songs. 

CD-DA 

A CD-DA (Audio CD) disc contains tracks with Audio only. This type of disc is defined by the Red 
Book format standard. 

CD-ROM 

A CD-ROM disc contains only data. This type of disc is defined by the Yellow Book. Format standard. 

CD Extra 

CD Extra, also known as CD Plus or Enhanced CD, includes two sessions with the first session 
containing up to 98 audio tracks and the second session containing a data track written in the CD-ROM 
XA format. 
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CD Label 

CD Labels are circular labels with an adhesive side to stick to the top side of your CD. 

d-characters 

d characters include capital A to Z, digits 0 to 9, and underscore symbol ( _) .  

Disc-At-Once 

With Disc-At-Once writing mode, the CD-Recorder laser will not stop until the whole disc recording is 
finished. In this writing mode, the disc will be closed and there are no link blocks between any two 
tracks. 

Editing Area 

This is the work area in JewelCase Maker where you insert and arrange your graphic and text objects. 
You may create your own graphic object or select one from a previously saved file. Graphic objects can 
be positioned in on top of or under other objects, selected, moved and resized with the mouse or even 
edited by double clicking and entering the graphics application that you have previously installed for that 
type of graphics file. 
 
Text objects can be added to create play lists or other labels. They can be rotated and the format toolbar 
gives you full control over fonts and other properties. 

Front Cover 

Front cover inserts are printed on a single side of the paper. They are typically folded in half giving you a 
front and backside to the insert.  

Hybrid disc 

Usually, the term “hybrid” refers to a disc containing both DOS/Windows and Macintosh software in 
separate volumes. 

Inside Insert 

An Inside insert is created by designing and printing an additional page that will be printed on the 
backside or the front cover. When folded, you have a jewel case insert with four pages. 

ISO 9660 

ISO 9660 is an internationally accepted logical level standard for CD media. The standard allows 
different computers with different operating systems to access the same data format. 
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Label Set 

A JewelCase Maker label set contains your custom label definition. You can add graphics and text to 
create personalized jewel case inserts covers and CD labels. Each label set can contain a Front Cover, 
Inside Insert, Back Cover (U-Card) and a CD Label. Label sets are saved with a .jwc file extension.  

Lead-In Area 

This is a piece of information, laying before each session that contains the TOC (Table of Contents) 
and other miscellaneous information about the disc and about the recorded tracks. 

Lead-Out Area 

To indicate the end of a session, it is closed with an ending, called the Lead-Out. 

Joliet  

Microsoft implemented the Joliet file system. It is based on the ISO9660 level 3 standard.  
 
A CD created under the Joliet file system can only be read back under Windows 95 and Windows NT 
4.0 or later. The number of characters allowed in a long file name is up to 64 and the number of 
characters allowed in a long directory is up to 64 characters. However, the total number of characters of 
the long file name plus its full path cannot exceed 120. 

Mixed Mode CD  

A Mixed Mode CD contains a combination of CD-ROM tracks and CD-DA tracks. A Mixed Mode 
disc has a CD-ROM track as the first track and CD-DA on the following tracks. 

Incremental Multisession  

Incremental Multisession recording links existing sessions with a new session being written to the disc. 
Data from a previous session can be accessed since the each session has links to the data written in the 
previous session. 

Independent Multisession 

Independent Multisession recording organizes multiple sessions as completely separate volumes, each 
with its own directory of information. In most cases, you will need a utility such as Session Explorer to 
view data from a previously recorded session on the disc. 

MPEG-1, Layer 3 (.mp3) 

MPEG-1, Layer 3, or MP3 as it is more commonly known, is the portion of the MPEG-1 specification 
dealing with the recording of audio information to a file. This standard is gaining popularity on the 
Internet. Currently, most CD drives will not play this audio format directly.  NTI CD-Maker will decode 
MP3 files on the fly to wave files before they are written to the disc. 
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Multisession 

Multisession refers to a form of recording that allows data to be written over more than one session.  
The disc can be removed from the recorder in between sessions and then replaced. 

Packet-Recording 

Packet-Recording allows small packets of data to be written one packet at a time. Packet-Recording 
works only with data tracks. It is only supported by the FileCD utility. 

Paper Type  

A description of a label stock like Avery's 8931 or you may define your own paper type using the Page 
Setup item from the File Menu. Each page must have a paper type selected in order to be printed or 
viewed with the Print Preview feature. 

Path Table 

The Path Table contains the addresses of the Directory Files so that data files can be accessed directly. 

Primary Volume Descriptor (PVD) 

Relationship reference information about the CD file system to the medium. It refers to the Path Table, 
and to the Root Directory. 

Program Calibration Area (PCA) 

The PCA is disc space for the CD recorder to calibrate the laser power needed for recording on the disc 
via a trial recording. 

Program Memory Area (PMA) 

The PMA contains information about the recordings on the disc. Before you close the current session, 
to keep track of all data recorded, PMA (sort of a pre-TOC) is written to the disc in an area that is only 
accessible by the CD recorder. 

Romeo 

Romeo is defined as Windows 95 long file names only, up to 128 characters. 

Root Directory 

The Root Directory is a special Directory File, in that no other Directory file refers to it. 
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Ruler 

The ruler is positioned at the top and left side of the editing area. It can be displayed or disabled at your 
convenience and the unit of measure can be set to either inches or centimeters from the Ruler item in 
the View Menu. The exact position of the cursor appears as a dashed line on the ruler while working in 
the editing area. It is also displayed in the message area of the status bar if visible. 

SCSI 

SCSI, which stands for “Small Computer System Interface”, is a standard for a high-speed data transfer 
interface between computers and their peripheral devices. A SCSI interface usually allows up to eight 
different devices to be connected to a single controller. 

Session 

Session refers to data written to a CD during the span of a single recording.  It is an area on the disc that 
consists of a Lead-In Area, a Program Area and a Lead-out Area. 

Session-At-Once 

With Session-At-Once writing mode, the CD-Recorder’s laser does not stop until the all data from the 
current session is written to disc.  Session-At-Once is related to the process of recording multisession 
discs.  See Multisession. 

Spot 

A spot is another word for label. You may define up to three spots (labels) per paper type. You can 
print more than one copy of a label on the same page. 

Spot Outline 

The spot outline is displayed to show the boundaries for the label you are editing. The page selected on 
the Page toolbar determines the type of outline displayed. It may be printed to act as a guide for cutting 
out your labels and inserts from non-perforated paper types. 

Super Video CD 

A Super Video CD disc may include video clips, converted from MPEG-2 files. Video clips must 
conform to the MPEG-2 (ISO 13818-1, 1994) specification. 

Table of Contents (TOC) 

The Table of Contents (TOC) contains information about the disc and tracks. When you close the 
current session, the Table of Contents will be written in the Lead-In Area. With an unfinished recording 
of the disc, however, the TOC cannot be written to the disc.  
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Track-At-Once 

With Track-At-Once writing mode, the CD-recorder will record one track at a time. In between every 
track, the CD-recorder’s laser stops while the hard disk prepares the contents of the next track.  

Universal Disk Format (UDF) 

Universal Disk Format: a file system for optical media developed by the Optical Storage Technology 
Association (OSTA). It was designed for read-write interoperability between all the major operating 
systems as well as compatibility between rewritable and write-once media. UDF supports file names up 
to 255 characters long. 

Unit 

The JewelCase Maker program can work in either inches or centimeters for your convenience. The unit 
of measure can be selected in the Add printing paper dialog for paper type definitions or from the Ruler 
item in the View menu. 

Video CD 

A Video CD disc may include video clips, converted from MPEG files. Video clips must conform to 
the MPEG for Video CD specification, as defined by the White book format standard. 

Virtual CD Layout 

A Virtual CD Layout is an ISO-formatted directory that indicates how files will be arranged on your 
CD. The layout contains only information as to where those to-be-recorded files actually reside on your 
drives, while the actual contents of the files or directories are still on the original storage media. 

Wave 

A Wave (.wav) file is a file that stores analog signals (sounds) in a digital format that can be interpreted 
by a computer. 

WMA File 

The Microsoft® Windows Media™ Audio format can handle all types of audio content, from speech-
only audio recorded with a sampling rate of 8 kilohertz (kHz) to 48 kHz high-quality stereo music. 
WMA format files require much less disk space for storage than WAV or MP3 files. Currently, most 
CD drives will not play this audio format directly.  NTI CD-Maker will decode WMA files on the fly to 
wave files before they are written to the disc. 
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